Quantifiler® Human and Y Human Male DNA Quantification Kits

For use with:
Quantifiler® Human DNA Quantification Kit (Cat. no. 4343895)
Quantifiler® Y Human Male DNA Quantification Kit (Cat. no. 4343906)

Publication Number 4344790
Revision G
# Contents

About This Guide .......................... 11
Revision history .......................... 11

## CHAPTER 1  Overview .................... 13

Product overview .......................... 13
Purpose .................................. 13
Product description ....................... 13
Chemistry overview ....................... 14
Assay overview ........................... 14
Target-specific assay components ............. 14
About the targets .......................... 14
IPC assay components ..................... 14
About the probes ........................... 14
5’ Nuclease assay process ................... 15

Instrument overview ...................... 16
Fluorescence detection ...................... 16
SDS software overview ..................... 17
Composite spectrum ....................... 17
Processing multicomponent data ............... 17
Normalization of reporter signals ............. 18
Real-time data analysis .................... 18
Amplification plot example ................... 18
Phases of amplification .................... 19
Relationship of amplified PCR product to initial template concentration ............... 20
About the threshold ....................... 20
About the threshold cycle .................. 20
How \( C_T \) values are determined .......... 21
Relationship of threshold cycles to initial template amount .................. 21

Procedural overview ...................... 22
Materials and equipment ................... 22
Kit contents and storage ................... 22
Additional storage guidelines for primer mixes ................... 22
Equipment and materials not included ........... 23
CHAPTER 2 Software Setup .............................................. 25

Section 2.1 7000 SDS Software Setup .................................. 26
Overview ........................................................................... 26
Purpose ............................................................................. 26
Configuration .................................................................... 26
Start the 7000 SDS .......................................................... 26
Overview ........................................................................... 26
Start the computer ................................................................ 26
Power on the instrument ...................................................... 27
Start SDS software .............................................................. 27
About plate documents ......................................................... 27
How plate documents are used .............................................. 27
Plate document types .......................................................... 28
Example plate document setup ............................................. 28
Set up a plate document ....................................................... 29
Overview ........................................................................... 29
Create a blank plate document ............................................. 29
Create detectors .................................................................. 30
Add detectors to the plate document ..................................... 32
Apply detectors for standards ............................................... 32
Apply detectors for unknown samples ................................. 34
Add sample names for unknown samples ............................. 34
Set thermal cycler conditions ............................................... 35
Save the plate document ...................................................... 37
Set up a plate document template ......................................... 37
Purpose ............................................................................. 37
Template settings ................................................................ 37
Creating a plate document template ..................................... 37
Create a plate document from a template ............................ 38

Section 2.2 7900HT SDS Software Setup ............................... 40
Overview ........................................................................... 40
Purpose ............................................................................. 40
Configuration .................................................................... 40
Start the 7900HT Real-Time PCR System ............................. 40
Overview ........................................................................... 40
Start the 7900HT System ..................................................... 40
About plate documents ......................................................... 41
How plate documents are used .............................................. 41
Plate document types .......................................................... 41
Example plate document setup ............................................. 41
Set up a plate document ....................................................... 42
Overview ........................................................................... 42
Create a blank plate document ............................................. 43
## Contents

Create detectors ........................................................................ 43  
Copy detectors to the plate document ..................................... 45  
Apply detectors for standards .................................................. 45  
Apply detectors for unknown samples ....................................... 46  
Add sample names to unknown samples ................................... 46  
Set thermal cycler conditions .................................................. 47  
Save the plate document .......................................................... 48  
Set up a plate document template ............................................. 48  
Purpose .................................................................................. 48  
Template settings ..................................................................... 48  
Create a plate document template ............................................ 49  
Create a plate document from a template ................................. 50

### CHAPTER 3  PCR Amplification ............................................ 51

Prepare the DNA quantification standard .................................. 51  
Required materials .................................................................. 51  
Guidelines for calculating the standards dilution series ............. 51  
Standards dilution series example ............................................ 51  
Preparation guidelines ............................................................. 52  
Prepare the DNA quantification standards ............................... 52  
Prepare the reactions ............................................................... 53  
Required materials .................................................................. 53  
Prepare the reactions ............................................................... 53  
Run the reactions ................................................................... 54  
Before you run the reactions ................................................... 54  
Run the plate on the 7900 SDS ............................................... 54  
Run the plate on the 7900HT SDS .......................................... 55

### CHAPTER 4  Data Analysis and Results ............................... 57

Section 4.1 7000 SDS Data Analysis ........................................ 58

Analyze the plate document ..................................................... 58  
View results ............................................................................ 58  
Overview ............................................................................... 58  
View the standard curve .......................................................... 58  
Amplification plot results .......................................................... 59  
View the amplification plot ....................................................... 59  
View the report ....................................................................... 59  
Print or export the report .......................................................... 60

Section 4.2 7900HT SDS Data Analysis ................................... 61

Analyze the plate document ..................................................... 61  
View results ............................................................................ 61  
Overview ............................................................................... 61  
View the standard curve .......................................................... 62
## CHAPTER 5 Interpretation of Results ................................. 65

Check analysis settings ........................................... 65
  Check analysis settings on the 7000 SDS ..................... 65
  Check analysis settings on the 7900HT SDS .................. 66
Examine the standard curve ..................................... 66
  About standard curve results ................................. 66
  R² value ..................................................... 67
  R² value < 0.98 for Quantifiler® Y Kit only .................. 67
  Slope ...................................................... 67
Troubleshoot the standard curve ................................ 68
  Example 1 ................................................. 69
  Example 2 ................................................. 69
  Example 3 ................................................. 70
Using the Internal PCR Control system .......................... 70
  Purpose .................................................... 70
  Components .............................................. 71
  Interpret IPC results ....................................... 71
  True negative results ..................................... 71
  Invalid IPC results ....................................... 71
  Disregard IPC results ..................................... 71
  Partial PCR inhibition .................................... 71
  Determine the normal range for IPC ......................... 71
  Evaluate PCR inhibition .................................. 72
Troubleshoot amplification plots ................................ 73
Assess quantity .................................................. 77
  Purpose .................................................... 77
  Assay sensitivity ......................................... 77
  Stochastic effects ....................................... 77
  Validity .................................................... 77
  If insufficient DNA is present .............................. 77

## CHAPTER 6 Data Analysis and Results ............................... 79

Overview ......................................................... 80
  About this chapter ......................................... 80
  Importance of validation .................................. 80
  Experiments ............................................... 80
Section 6.2 Applied Biosystems® 7900HT Real-Time PCR System Validation
(SDS Software v2.0) ................................................................. 104
  Overview ................................................................. 104
  Precision (7900HT SDS) .................................................. 104
    Experiment ......................................................... 104
    Results ......................................................... 104
  Mixture Studies (7900HT SDS) .................................... 105
    Experiment ......................................................... 106
    Results ......................................................... 106
  Comparisons with other methods (7900HT SDS) ............ 107
    Experiment ......................................................... 107
    Results ......................................................... 108

Section 6.3 Casework Sample Analysis ................................. 109
  Case type studies ...................................................... 109
  Experiment ......................................................... 109
  Results ................................................................. 109

Section 6.4 Applied Biosystems® 7500 Real-Time PCR System Validation
(SDS Software v1.2.3) ........................................................ 113
  Overview ................................................................. 113
    Validation experiments performed .................................. 113
  Materials and methods ................................................ 113
    Reagents ......................................................... 113
    Instruments ..................................................... 113
  Experimental setup .................................................. 114
    Precision and accuracy testing .................................. 114
    Reproducibility and sensitivity testing ......................... 114
    Background testing ............................................. 115
  Data collection .......................................................... 115
  Data analysis .............................................................. 115
    Initial data compiling and analysis ................................ 115
    Statistical data analysis .......................................... 116
    Precision and accuracy ............................................ 116
    Reproducibility and sensitivity .................................... 118
    Background ...................................................... 120
    Auto Baseline analysis versus Manual analysis ............... 121
  Discussion ................................................................. 122
    Precision and accuracy ............................................ 122
    Reproducibility and sensitivity .................................... 122
    Auto Baseline analysis versus Manual analysis ............... 123
  Conclusion ................................................................. 123
About This Guide

IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix in this document.

Revision history

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description of change</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>January 2014</td>
<td>Update format, no technical changes</td>
</tr>
</tbody>
</table>
Product overview

Purpose
The Quantifiler® Human DNA Quantification Kit (Quantifiler® Human Kit) (Cat. no. 4343895) and the Quantifiler® Y Human Male DNA Quantification Kit (Quantifiler® Y Kit) (Cat. no. 4343906) are designed to quantify the total amount of amplifiable human (and higher primate) DNA or human male DNA in a sample. The results from using the kits can aid in determining:

- If sufficient human DNA or human male DNA is present to proceed with short tandem repeat (STR) analysis
- How much sample to use in STR analysis applications

Product description
The Quantifiler® Kits contain all the necessary reagents for the amplification, detection, and quantification of a human-specific DNA target or a human male-specific DNA target.

The reagents are designed and optimized for use with the following instruments and software:

- ABI PRISM® 7000 Sequence Detection System and SDS Software v1.0
- Applied Biosystems® 7900HT Sequence Detection System (no automation module) and SDS Software v2.0.

See Chapter 6, “Data Analysis and Results” for validation studies performed using the Applied Biosystems® 7500 Real-Time PCR System with SDS Software v1.2.3 and the ABI PRISM® 7000 Sequence Detection System with SDS Software v1.2.3.
Chemistry overview

Assay overview
The DNA quantification assay combines two 5’ nuclease assays:
- A target-specific (human DNA or human male DNA) assay
- An internal PCR control (IPC) assay

Target-specific assay components
The target-specific assay consists of:
- Two primers for amplifying human DNA or human male DNA
- One TaqMan® MGB probe labeled with FAM™ dye for detecting the amplified sequence

About the targets
Table 1 provides information about the targets of PCR amplification in the Quantifiler® Human Kit and the Quantifiler® Y Kit.

<table>
<thead>
<tr>
<th>Kit</th>
<th>Gene Target</th>
<th>Location</th>
<th>Amplicon Length</th>
<th>Region Amplified</th>
<th>Ploidy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human Kit</td>
<td>Human telomerase reverse transcriptase gene (hTERT)</td>
<td>5p15.33</td>
<td>62 bases</td>
<td>Nontranslated region (intron)</td>
<td>Diploid†</td>
</tr>
<tr>
<td>Quantifiler® Y Kit</td>
<td>Sex-determining region Y gene (SRY)</td>
<td>Yp11.3</td>
<td>64 bases</td>
<td>Nontranslated region</td>
<td>Haploid†</td>
</tr>
</tbody>
</table>

† Single-copy target

IPC assay components
The IPC assay consists of:
- IPC template DNA (a synthetic sequence not found in nature)
- Two primers for amplifying the IPC template DNA
- One TaqMan® MGB probe labeled with VIC® dye for detecting the amplified IPC DNA

About the probes
The TaqMan® MGB probes contain:
- A reporter dye (FAM™ dye or VIC® dye) linked to the 5’ end of the probe
- A minor groove binder (MGB) at the 3’ end of the probe
- This modification increases the melting temperature (Tm) without increasing probe length (Afonina et al., 1997; Kutyavin et al., 1997), which allows the design of shorter probes.
- A nonfluorescent quencher (NFQ) at the 3’ end of the probe
- Because the quencher does not fluoresce, Life Technologies sequence detection systems can measure reporter dye contributions more accurately.
5’ Nuclease assay process

The 5’ nuclease assay process (Figure 1 through Figure 5) takes place during PCR amplification. This process occurs in every cycle and does not interfere with the exponential accumulation of product.

Figure 1 Legend for 5’ nuclease assay process figures

\[
\begin{array}{c}
P = \text{AmpliTaq Gold® DNA Polymerase} \\
\text{NFQ} = \text{Nonfluorescent quencher} \\
\text{MGB} = \text{Minor groove binder} \\
\text{R} = \text{Reporter}
\end{array}
\]

During PCR, the TaqMan® MGB probe anneals specifically to a complementary sequence between the forward and reverse primer sites (Figure 2).

When the probe is intact (Figure 2 and Figure 3), the proximity of the reporter dye to the quencher dye results in suppression of the reporter fluorescence primarily by Förster-type energy transfer (Förster, 1948; Lakowicz, 1983).

Figure 2 Polymerization

Figure 3 Strand displacement

AmpliTaq Gold® DNA polymerase cleaves only probes that are hybridized to the target (Figure 4). Cleavage separates the reporter dye from the quencher dye, which results in increased fluorescence by the reporter. The increase in fluorescence signal occurs only if the target sequence is complementary to the probe and is amplified during PCR. Because of these requirements, nonspecific amplification is not detected.
Polymerization of the strand continues, but because the 3′ end of the probe is blocked, there is no extension of the probe during PCR (Figure 5).

**Detection on the ABI PRISM® 7000 Sequence Detection System**

1. A tungsten-halogen lamp directs light to each well on the reaction plate. The light passes through the Optical Adhesive Cover and excites the fluorescent dyes in each well of the plate.

2. A system of lenses, filters, and a dichroic mirror focuses the fluorescence emission into a charge-coupled device (CCD) camera.

3. Based on wavelength, the filters separate the light into a predictably spaced pattern across the CCD camera.

4. During the run, the CCD camera detects the fluorescence emission between 500 nm and 660 nm from each well.

5. The SDS software obtains the fluorescence emission data from the CCD camera and applies data analysis algorithms.

**Detection on the Applied Biosystems® 7900HT Sequence Detection System**

1. An argon ion laser directs light to each well on the microplate. The light passes through the Optical Adhesive Cover and excites the fluorescent dyes in each well of the plate.

2. A system of lenses, filters, and a dichroic mirror focuses the fluorescence emission into a grating.
3. Based on wavelength, the grating separates the light into a predictably spaced pattern across the CCD camera.

4. During the run, the CCD camera detects the fluorescence emission between 500 nm and 660 nm from each well.

5. The SDS software obtains the fluorescence emission data from the CCD camera and applies data analysis algorithms.

**SDS software overview**

This section describes how the SDS software analyzes raw run data from real-time runs. Raw data consists of the spectral data between 500 nm to 660 nm collected by the SDS software during a sequence detection run.

**Composite spectrum**

Figure 6 shows a composite fluorescence spectrum from a single well containing the passive reference, one probe labeled with FAM™ dye and a nonfluorescent quencher, and one probe labeled with VIC® dye and a nonfluorescent quencher. The example shows how the overlapping component dye spectra contribute to the composite spectrum.

**Figure 6** Example of a composite spectrum

**Processing multicomponent data**

During the multicomponent transformation, the SDS software uses algorithms to determine the contribution of each dye:

- An algorithm removes the background component stored in the background calibration file to eliminate the contribution of background fluorescence in the raw data.
- The software uses the extracted pure dye standards to express the composite spectrum in terms of the pure dye components.
- Then, an algorithm applies matrix calculations to determine the contributions of each component dye to the composite spectrum.
The software uses the pure dye spectra, generated as part of instrument calibration, to solve for coefficients $a$, $b$, and $c$ and to calculate the mean standard error (MSE) in the following equation:

$$\text{Measured spectrum} = a(\text{FAM}) + b(\text{VIC}) + c(\text{ROX}) + d(\text{Background}) + \text{MSE}$$

where coefficients $a$, $b$, and $c$ represent the contribution of each dye to the composite spectrum. The MSE value indicates how closely the collective multicomponent spectrum conforms to the raw spectra.

**Note:** The example equation above assumes that pure dye components exist for FAM™ dye, VIC® dye, and ROX™ dye and for the instrument background.

**Figure 7** Typical component contributions in a multiplex reaction

---

**Normalization of reporter signals**

The SDS software displays cycle-by-cycle changes in normalized reporter signal ($R_n$). The SDS software normalizes each reporter signal by dividing it by the fluorescent signal of the passive reference dye. Because the passive reference is one component of the PCR master mix, it is present at the same concentration in all wells of the reaction plate. By normalizing the reporter signal using the passive reference, the software can account for minor variations in signal caused by pipetting inaccuracies and make better well-to-well comparisons of reporter signal.

**Real-time data analysis**

The 7000 SDS and the 7900HT SDS can be used to determine the relative quantity of a target nucleic acid sequence in a sample by analyzing the cycle-to-cycle change in fluorescent signal as a result of amplification during a PCR (Figure 8).

**Amplification plot example**

When using TaqMan® probes with the 7000 SDS or 7900HT SDS, the fluorescent signal (or normalized reporter, $R_n$) increases as the amount of specific amplified product increases. Figure 8 shows the amplification of PCR product in a plot of $R_n$ vs. cycle number during PCR. This amplification plot contains three distinct phases that characterize the progression of the PCR.
Phases of amplification

Initially, $R_n$ appears as a flat line because the fluorescent signal is below the detection limit of the sequence detector.

Phase 1: Geometric (Exponential)

Signal is detected and increases in direct proportion to the increase of PCR product. As PCR product continues to increase, the ratio of AmpliTaq Gold® DNA polymerase to PCR product decreases.

During the geometric phase, amplification is characterized by a high and constant efficiency. It occurs between the first detectable rise in fluorescence and before the beginning of the linear phase. During the geometric phase, a plot of DNA concentration versus cycle number on a log scale should approximate a straight line with a slope. Typically, the SDS system is sufficiently sensitive to detect at least 3 cycles in the geometric phase, assuming reasonably optimized PCR conditions. When the template concentration reaches $10^{-8}$ M, PCR product stops accumulating exponentially.

Phase 2: Linear

During the linear phase, the slope of the amplification plot decreases steadily. At this point, one or more components of the PCR has decreased below a critical concentration, and the amplification efficiency begins to decrease. This phase is termed linear because amplification approximates an arithmetic progression, rather than a geometric increase. Because the amplification efficiency is continually decreasing during the linear phase, it exhibits low precision.

Phase 3: Plateau

The amplification plot achieves the plateau phase when the PCR stops, the $R_n$ signal remains relatively constant, and the template concentration reaches a plateau at about $10^{-7}$ M (Martens and Naes, 1989).
Because of the progressive cleavage of TaqMan® fluorescent probes during the PCR, as the concentration of amplified product increases in a sample, so does the Rn value. The following equation describes the relationship of amplified PCR product to initial template during the geometric phase:

\[ N_c = N(1 + E)^c \]

where \( N_c \) is the concentration of amplified product at any cycle, \( N \) is the initial concentration of target template, \( E \) is the efficiency of the system, and \( c \) is the cycle number.

For example, with the dilutions of RNase P target in the TaqMan® RNase P Instrument Verification Plate, the ratio of template concentration to detectable signal is preserved in the geometric phase for all dilutions (Figure 9). As the rate of amplification approaches a plateau, the amount of product is no longer proportional to the initial number of template copies.

**Figure 9** Amplification plot from a real-time run of an RNase P Instrument Verification Plate

The SDS software uses a threshold setting to define the level of detectable fluorescence. Based on the number of cycles required to reach the threshold, the SDS software can compare test samples quantitatively: A sample with a higher starting template copy number reaches the threshold earlier than a sample with a lower starting template copy number.

The threshold cycle (\( C_T \)) for a specified amplification plot occurs when the fluorescent signal increases beyond the value of the threshold setting. The \( C_T \) value depends on:

- Starting template copy number
- Efficiency of DNA amplification by the PCR system
How \( C_T \) values are determined

To determine the \( C_T \) value, the SDS software uses the \( R_n \) values collected from a predefined range of PCR cycles called the baseline (the default baseline occurs between cycles 6 and 15 on the 7000 SDS and between cycles 3 and 15 on the 7900HT SDS):

1. The software generates a baseline-subtracted amplification plot of \( \Delta R_n \) versus cycle number.
2. An algorithm defines the cycle where the \( \Delta R_n \) value crosses the threshold setting (the default threshold setting is 0.2) as the threshold cycle (\( C_T \)).

Relationship of threshold cycles to initial template amount

The following equation describes the exponential amplification of the PCR:

\[
X_n = X_m (1 + EX)^{n-m}
\]

where:
- \( X_n \) = number of target molecules at cycle \( n \) (so that \( n > m \))
- \( X_m \) = number of target molecules at cycle \( m \)
- \( EX \) = efficiency of target amplification (between 0 and 1)
- \( n - m \) = number of cycles elapsed between cycle \( m \) and cycle \( n \)

Amplicons designed and optimized according to our guidelines (amplicon size <150 bp) have amplification efficiencies that approach 100%. Therefore \( EX = 1 \) so that:

\[
X_n = X_m (1 + 1)^{n-m} = X_m (2)^{n-m}
\]

To define the significance in amplified product of one thermal cycle, set \( n - m = 1 \) so that:

\[
X_n = X_m (2)^1 = 2X_m
\]

Therefore, each cycle in the PCR reaction corresponds to a two-fold increase in product. Likewise, a difference in \( C_T \) values of 1 equates to a two-fold difference in initial template amount.
**Procedural overview**

Use of the Quantifiler® Kits involves the following workflow:

1. **Software Setup**
2. **PCR Amplification**
3. **Data Analysis**
4. **Interpretation of Results**

**Materials and equipment**

Each Quantifiler® Kit contains materials sufficient to perform 400 reactions at a 25-µL reaction volume.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Contents</th>
<th>Quantity</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human Primer Mix or</td>
<td>Forward and reverse primers to amplify human DNA or human male DNA target</td>
<td>3 tubes, 1.4 mL each</td>
<td>−15 to −25 °C</td>
</tr>
<tr>
<td>Quantifiler® Y Human Male Primer Mix</td>
<td>Probe to detect human DNA or human male DNA target</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>IPC system primers, template, and probe</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantifiler® Human DNA Standard</td>
<td>200 ng/µL purified DNA standard</td>
<td>1 tube, 120 µL</td>
<td>−15 to −25 °C</td>
</tr>
<tr>
<td>Quantifiler® PCR Reaction Mix</td>
<td>AmpliTaq Gold® DNA Polymerase, dNTPs with dUTP, Passive Reference, and optimized buffer components</td>
<td>1 tube, 5 mL</td>
<td>2 to 8 °C</td>
</tr>
</tbody>
</table>

**Additional storage guidelines for primer mixes**

Follow the additional guidelines for storing the primer mixes:

- Minimize freeze-thaw cycles.
- Keep protected from direct exposure to light. Excessive exposure to light may affect the fluorescent probes.
Table 3 through Table 5 list required and optional equipment and materials not supplied with the Quantifiler® Kits.

### Table 3  Equipment

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems® 7900HT Real-Time PCR System (no automation)</td>
<td>Contact your local Life Technologies sales representative.</td>
</tr>
<tr>
<td>ABI PRISM® 7000 Sequence Detection System</td>
<td></td>
</tr>
<tr>
<td>Tabletop centrifuge with 96-well plate adapters (optional)</td>
<td>major laboratory supplier (MLS)</td>
</tr>
</tbody>
</table>

### Table 4  User-supplied materials

<table>
<thead>
<tr>
<th>Material</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human DNA Quantification Kit</td>
<td>Life Technologies (Cat. no. 4343895)</td>
</tr>
<tr>
<td>Quantifiler® Y Human Male DNA Quantification Kit</td>
<td>Life Technologies (Cat. no. 4343906)</td>
</tr>
<tr>
<td>Glycogen, 20 mg (1 mL)</td>
<td>Roche Applied Science (Cat. no. 901 393)</td>
</tr>
</tbody>
</table>

### High-Throughput Setup

<table>
<thead>
<tr>
<th>Material</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-Well Optical Reaction Plates</td>
<td>Life Technologies (Cat. no. 4306737)</td>
</tr>
<tr>
<td>Optical Adhesive Covers Starter Kit [20 covers, 1 compression pad, 1 applicator]</td>
<td>Life Technologies (Cat. no. 4313663)</td>
</tr>
<tr>
<td>Optical Adhesive Covers (100 covers)</td>
<td>Life Technologies (Cat. no. 4311971)</td>
</tr>
<tr>
<td>MicroAmp® Splash Free Support Base</td>
<td>Life Technologies (Cat. no. 4312063)</td>
</tr>
</tbody>
</table>
## Materials and equipment

### Mid-to-Low-Throughput Setup

<table>
<thead>
<tr>
<th>Material</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp® Optical Tubes (8 tubes/strip, 125 strips)</td>
<td>Life Technologies (Cat. no. 4316567)</td>
</tr>
<tr>
<td>MicroAmp® 96-Well Tray/Retainer Set</td>
<td>Life Technologies (Cat. no. 403081)</td>
</tr>
<tr>
<td>Optical Caps (8 caps/strip, 300 strips)</td>
<td>Life Technologies (Cat. no. 4323032)</td>
</tr>
<tr>
<td>Compression pad from Optical Adhesive Covers Starter Kit</td>
<td>Life Technologies (Cat. no. 4313663)</td>
</tr>
</tbody>
</table>

**Note:** Not necessary if using Optical Caps

### Table 5 Documents

<table>
<thead>
<tr>
<th>Document</th>
<th>Life Technologies Pub. no.</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>ABI PRISM® 7000 Sequence Detection System User Guide</em></td>
<td>4317596</td>
</tr>
<tr>
<td><em>Applied Biosystems® 7900HT Sequence Detection System User Guide</em></td>
<td>4317596</td>
</tr>
</tbody>
</table>
Software Setup

- Section 2.1 7000 SDS Software Setup ............................................. 26
  Overview .......................................................................................... 26
  Start the 7000 SDS ......................................................................... 26
  About plate documents ...................................................................... 27
  Set up a plate document ................................................................... 29
  Set up a plate document template .................................................... 37
- Section 2.2 7900HT SDS Software Setup ............................................. 40
  Overview .......................................................................................... 40
  Start the 7900HT Real-Time PCR System ....................................... 40
  About plate documents ...................................................................... 41
  Set up a plate document ................................................................... 42
  Set up a plate document template .................................................... 48
Section 2.1 7000 SDS Software Setup

Overview

Purpose
During software setup, you start up the ABI PRISM® 7000 Sequence Detection System (7000 SDS) and set up a plate document for DNA quantification using the Quantifiler® Kits.

Configuration
The Quantifiler® Kits are supported using the 7000 SDS and Sequence Detection Systems (SDS) Software v1.0 for real-time data collection and analysis.

Start the 7000 SDS

Overview
Starting the 7000 SDS involves:

1. Start the computer
2. Power on the instrument (page 27)
3. Start SDS software (page 27)

Start the computer
1. If you are using the laptop computer, open it by pushing in the front, center button, holding it, and lifting up the lid.
2. Press the power button on the computer.
3. In the Enter User name field of the login window, type your name or the user name associated with the computer.

4. In the Enter User name field of the login window, type your name or the user name associated with the computer.

5. If required, type your password in the Password field.

Power on the instrument

**Note:** Wait for the computer to finish starting up before powering on the 7000.

Press the power button on the lower left front of the instrument.

Start SDS software

Select Start > ABI Prism 7000 > ABI Prism 7000 SDS Software.

The software attempts to initialize the instrument and displays a message in the status bar for a few seconds. Then the computer attempts to establish communication with the 7000 instrument. If the connection is successful, the software displays in the status bar.

---

About plate documents

How plate documents are used

Running a reaction plate on the 7000 SDS requires creating and setting up a plate document using the SDS software. A plate document is a representation of the arrangement of samples (standards and unknowns) and detectors on the reaction plate. The SDS software uses the plate document to:

- Coordinate the instrument operation, such as thermal cycling and data collection
- Organize and store the data gathered during the run
- Analyze the data from the run
Plate document types

You can use the SDS software to create two types of plate document files.

<table>
<thead>
<tr>
<th>Plate Document Type</th>
<th>File Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDS document</td>
<td>*.sds</td>
<td>Primary file to use when performing a run. Required for all experiments.</td>
</tr>
<tr>
<td>SDS template</td>
<td>*.sdt</td>
<td>File that already contains run parameters that are commonly used in plate documents, such as detectors, thermal cycler conditions, and so on. Streamlines the creation of the SDS document (*.sds) file.</td>
</tr>
</tbody>
</table>

Example plate document setup

You can arrange the reactions in any well of the reaction plate, but you need to set up the plate document so that it corresponds exactly to the arrangement of the standards and unknown samples in the wells of the reaction plate. Table 6 shows one example of arranging reactions when running two Quantifiler® Kits on one 96-well reaction plate:

- Wells A1 through D12 (gray) correspond to reactions using the Quantifiler® Human DNA Quantification Kit (Quantifiler® Human Kit)
- Wells E1 through H12 (white) correspond to reactions using the Quantifiler® Y Human Male DNA Quantification Kit (Quantifiler® Y Kit)

For each Quantifiler® Kit assay, there are eight DNA quantification standards and two reactions for each standard. See “Prepare the DNA quantification standard” on page 51 for more information about the DNA quantification standards.

Table 6  Example plate setup of reactions with two kits

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Std 1</td>
<td>Std 1</td>
<td>Std 2</td>
<td>Std 2</td>
<td>Std 3</td>
<td>Std 3</td>
<td>Std 4</td>
<td>Std 4</td>
<td>Std 5</td>
<td>Std 5</td>
<td>Std 6</td>
<td>Std 6</td>
</tr>
<tr>
<td>B</td>
<td>Std 7</td>
<td>Std 7</td>
<td>Std 8</td>
<td>Std 8</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>C</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>D</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>E</td>
<td>Std 1</td>
<td>Std 1</td>
<td>Std 2</td>
<td>Std 2</td>
<td>Std 3</td>
<td>Std 3</td>
<td>Std 4</td>
<td>Std 4</td>
<td>Std 5</td>
<td>Std 5</td>
<td>Std 6</td>
<td>Std 6</td>
</tr>
<tr>
<td>F</td>
<td>Std 7</td>
<td>Std 7</td>
<td>Std 8</td>
<td>Std 8</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>G</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>H</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
</tbody>
</table>

Table 7 shows another example of arranging reactions when running two Quantifiler® Kits on one 96-well reaction plate if you are using repeat pipettors:

- Wells A1 through D6 (gray) correspond to reactions using the Quantifiler® Human Kit
- Wells A7 through H12 (white) correspond to reactions using the Quantifiler® Y Kit

For each Quantifiler® Kit assay, there are eight DNA quantification standards and two reactions for each standard. See “Prepare the DNA quantification standard” on page 51 for more information about the DNA quantification standards.
**Table 7** Example plate setup of reactions using repeat pipettors

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Std 1</td>
<td>Std 1</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 1</td>
<td>Std 1</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>B</td>
<td>Std 2</td>
<td>Std 2</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 2</td>
<td>Std 2</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>C</td>
<td>Std 3</td>
<td>Std 3</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 3</td>
<td>Std 3</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>D</td>
<td>Std 4</td>
<td>Std 4</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 4</td>
<td>Std 4</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>E</td>
<td>Std 5</td>
<td>Std 5</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 5</td>
<td>Std 5</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>F</td>
<td>Std 6</td>
<td>Std 6</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 6</td>
<td>Std 6</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>G</td>
<td>Std 7</td>
<td>Std 7</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 7</td>
<td>Std 7</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>H</td>
<td>Std 8</td>
<td>Std 8</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 8</td>
<td>Std 8</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
</tbody>
</table>

### Set up a plate document

**Overview**
Setting up a plate document to run Quantifiler® Kit assays involves:

1. Create a blank plate document (page 29)
2. Create detectors (the first time only, page 30)
3. Add detectors to the plate document (page 32)
4. Apply detectors for standards (page 32)
5. Apply detectors for unknown samples (page 34)
6. Add sample names for unknown samples (page 34)
7. Set thermal cycler conditions (page 35)
8. Save the plate document (page 37)

**Create a blank plate document**

To create a blank plate document:

1. If the SDS software is not already started, select **Start ➤ Programs ➤ ABI Prism 7000 ➤ ABI Prism 7000 SDS Software**.
2. In the SDS software, select **File ➤ New** to open the New Document dialog box.
3. Click **OK** to use the default settings and to view a blank plate document:

![Blank plate document](image)

**Create detectors**

Before you set up the plate document, you need to create detectors in the SDS software for running Quantifiler® Kit assays. After the detectors are created, you do not need to create detectors for subsequent runs of Quantifiler® Kit assays and you can skip to “Add detectors to the plate document” on page 32.

To create detectors:

1. Select **Tools** ➤ **Detector Manager**.

2. In the lower left part of the Detector Manager dialog box, select **File** ➤ **New** to open the New Detector dialog box.

3. Create a detector for the Quantifiler® Human kit:

   ![New Detector dialog box](image)

   - **Enter** **Quantifiler Human**
   - **Select** **FAM**
   - **Make sure** **(none)** **is selected**
   - **Click to select a color**

4. Click **Create Another** to add the Quantifiler Human detector and to reset the New Detector dialog box.
5. Create a detector for the Quantifiler® Y kit:

   - Enter **Quantifiler Y**
   - Select **FAM**
   - Make sure (none) is selected
   - Click to select a color

6. Click **Create Another** to add the Quantifiler® Y detector and to reset the New Detector dialog box.

7. Create a detector for the IPC assay:

   - Enter **IPC**
   - Select **VIC**
   - Make sure (none) is selected
   - Click to select a color

8. Click **OK** to add the IPC detector and to return to the Detector Manager dialog box.
### Add detectors to the plate document

To add detectors to the plate document:

1. In the SDS software, select **Tools > Detector Manager**. If the detectors for the Quantifiler® Kits have been created, they are listed in the Detector Manager:

   ![Detector Manager](image1)

   2. In the Detector Manager, select the **Quantifiler Human**, **Quantifiler Y**, and the **IPC** detectors by clicking them while pressing the Ctrl key.

   ![Detector Manager](image2)

   3. Click **Add To Plate Document**.

   4. Click **Done** to close the Detector Manager.

### Apply detectors for standards

You need to apply detectors to the plate document for the wells on the reaction plate that contain DNA quantification standards. Repeat the procedure until you complete applying detector tasks, quantities, and sample names for all quantification standards.

**IMPORTANT!** Set up detectors for each quantity and for each kit separately. For example, set up detectors for quantification standard 1 for the Quantifiler® Human Kit first, and then for quantification standard 2 for the Quantifiler® Human Kit, and so on, until you finish setting up the detectors for all wells containing quantification standards.
Section 2.1 7000 SDS Software Setup
Set up a plate document

To apply detectors for quantification standards:

1. Select View ▶ Well Inspector to open the dialog box:

   ![Well Inspector dialog box image]

   **Note:** The Well Inspector displays the detectors that were added to the plate document.

2. On the Plate tab, select wells that correspond to a specific quantification standard for one kit:

   ![Plate tab image]

3. With the wells selected, go to the Well Inspector and:

   a. Select the Use boxes for the applicable detectors:

      - IPC
      - Quantifier Human or Quantifier Y

   b. For the Quantifier Human or Quantifier Y detector, click Unknown in the Task column, then select Standard from the drop-down list.

   c. For the Quantifier Human or Quantifier Y detector, select the Quantity field for the appropriate detector and enter the quantity of DNA in the well.

   **IMPORTANT!** Although you do not enter units for Quantity, you must use a consistent unit (for example, ng/μL) for all standard quantities. The units used for standard quantities defines the quantification units for analysis results.

   **Note:** Leave the IPC detector Task for standard reactions set to Unknown. Quantity values are not needed for IPC detectors.

   d. Enter the Sample Name (for example, Std. 1, Std. 2, and so on).
Apply detectors for unknown samples

You need to apply detectors to the plate document for the wells on the reaction plate that contain unknown samples.

**IMPORTANT!** If you run reactions for the Quantifiler® Human Kit and the Quantifiler® Y Kit on the same plate, apply detectors for unknown samples for each kit separately.

To apply detectors for unknown samples:

1. On the Plate tab, select the wells that correspond to all unknown samples for one Quantifiler® Kit.
2. With the well(s) selected, select View ▶ Well Inspector and check the Use boxes for the applicable detectors:
   - Quantifiler Human or Quantifiler Y
   - IPC

   For example:

   ![Well Inspector screenshot]

   Task for IPC set to Unknown (default)

   Make sure that ROX is selected

3. If you are running both kits on the reaction plate, repeat steps 1 and 2 for the unknown samples for the other kit.
4. Select View ▶ Well Inspector to close the Well Inspector.

Add sample names for unknown samples

Repeat the procedure to add sample names for all unknown samples.

To add sample names for unknown samples:

1. On the Plate tab, select one well containing an unknown sample.
2. With the well selected, select View ▶ Well Inspector and enter the Sample Name.
For example:

```
<table>
<thead>
<tr>
<th>Use</th>
<th>Detector</th>
<th>Reporter</th>
<th>Quench</th>
<th>Task</th>
<th>Quantity</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>Quantifier Human</td>
<td>FAM</td>
<td>(none)</td>
<td>Unknown</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✗</td>
<td>Quantifier Y</td>
<td>FAM</td>
<td>(none)</td>
<td>Unknown</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✗</td>
<td>IPC</td>
<td>VIC</td>
<td>(none)</td>
<td>Unknown</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Note: Samples with identical sample names are treated as replicates by the SDS software. Results for replicate reactions are grouped together automatically for data analysis.

Set thermal cycler conditions

Before running a Quantifier® Kit assay, you need to make two changes to the default thermal cycler conditions:

- Thermal profile
- Sample volume

To set thermal cycler conditions:

1. In the plate document, select the Instrument tab.
2. Press the Shift key and click within the Stage 1 hold step (50 °C for 2 minutes) to select it.
3. After the hold step is selected, press the Delete key.

4. Make sure that the thermal profile appears as follows:

5. Change the Sample Volume to 25 (μL) and make sure that the 9600 Emulation box is selected.

   **Note:** Selecting the 9600 Emulation box reduces the ramp rate.
Save the plate document

Before running the reaction plate, save the plate document as an SDS Document (*.sds) file.

**Note:** To save the plate document as a template, see “Set up a plate document template” on page 37.

To save the plate document:

1. Select File > Save.
2. Select the location for the plate document.
3. Enter a file name.
4. For Save as type, select SDS Documents (*.sds).
5. Click Save.

Set up a plate document template

**Purpose**

A plate document template reduces the time required to set up a plate document. This section describes how to create an SDS Template Document (*.sdt) for running Quantifiler® Kit assays.

**Template settings**

In addition to plate document settings (assay and container), templates can contain:

- Assay-specific detectors
- Well assignments for quantification standards, with detectors, tasks, and quantity
- Well assignments for unknown samples, with detectors and tasks
- Instrument settings: thermal cycler conditions and reaction volume settings

**Creating a plate document template**

This procedure assumes that you have created the detectors for running reactions using the Quantifiler® Kits (page 30).

To create a plate document template:

1. If the SDS software is not already started, select Start > Programs > ABI Prism 7000 > ABI Prism 7000 SDS Software.
2. Select File > New, complete the New Document dialog box, then click OK.
3. Apply the desired template settings to the plate document:
   • Add detectors to the plate document (page 32)
   • Apply detectors for standards and for unknown samples (page 32 and page 34)
   • Set thermal cycler conditions (page 35)

4. Select File ▶ Save As and complete the Save As dialog box:
   a. For Save as type, select SDS Templates (*.sdt).
   b. Locate and select the Templates folder within the software folder:
      X:Program Files ▶ ABI Prism 7000 ▶ Templates, where X is the hard drive on which the SDS software is installed.
      Saving the template file in the Templates folder makes the template available in the Template drop-down list of the New Document dialog box (see step 2 in “Create a plate document from a template” on page 38).
   c. For File name, enter a name for the template. For example, enter Quantifiler Template:

   ![Save the template file in the Templates folder]

   ![Enter a name for the template]

   d. Click Save.

Create a plate document from a template

After you create a template, you can use it to create a plate document:

1. If the SDS software is not already started, select Start ▶ Programs ▶ ABI Prism 7000 ▶ ABI Prism 7000 SDS Software.

2. Select File ▶ New and in the New Document dialog box and make the following selections:
   • For Assay, select Absolute Quantitation.
   • For Container, select 96-Well Clear.
   • For Template, select an appropriate template from the list.
   Note: If the template is not available in the list, click Browse to locate and select an appropriate template.
3. Complete the plate document setup:
   • Add detectors to the plate document (page 32)
   • Apply detectors for standards and for unknown samples (page 32 and page 34)
   • Set thermal cycler conditions (page 35)

   **Note:** The tasks that you perform vary according to which settings were defined in the template.

4. Save the plate document (page 37).
   For Save as type, select **SDS Documents (*.sds)**.
Section 2.2 7900HT SDS Software Setup

Overview

Purpose
During software setup, you start up the Applied Biosystems® 7900HT Real-Time PCR System and set up a plate document for DNA quantification using the Quantifiler® Kits.

Configuration
The Quantifiler® Kits are supported using the following configuration of the 7900HT Real-Time PCR System for real-time data collection and analysis:
- 96-well reaction plates
- Manual setup
- Sequence Detection Systems (SDS) software v2.0

Note: Use of the robotic microplate handler and/or 384-well reaction plates is not supported.

Start the 7900HT Real-Time PCR System

Overview
Starting the Applied Biosystems® 7900HT Real-Time PCR System involves:
1. Powering on the computer.
2. Powering on the instrument.
3. Starting the SDS software.

Start the 7900HT System
To start the 7900HT System:
1. Press the power buttons on the computer and on the monitor.
2. In the login screen, enter the User Name and Password.
3. Press the power button below the status lights on the front of the instrument.
At startup, the instrument:
- Emits a high-pitched tone, indicating that the system is initialized
- Cycles the status lights (red ► orange ► green), indicating that the instrument is active

4. Select **Start ► Programs ► Applied Biosystems ► SDS 2.0.**
At startup, the software attempts to establish communication with the 7900HT instrument. If the connection is successful, the software displays [Connected to: 580A1F88] in the status bar.

## About plate documents

### How plate documents are used
Running a reaction plate on the 7900HT Real-Time PCR System requires creating and setting up a plate document using the SDS software. A plate document is a representation of the arrangement of samples (standards and unknowns) and reagents on the reaction plate. The SDS software uses the plate document to:
- Coordinate the instrument operation, such as thermal cycling and data collection
- Organize and store the data gathered during the run
- Analyze the data from the run

### Plate document types
You can use SDS software to create two types of plate document files.

<table>
<thead>
<tr>
<th>Plate Document Type</th>
<th>File Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single plate document</td>
<td>*.sds</td>
<td>Primary file to use when performing a run. Required for all experiments.</td>
</tr>
<tr>
<td>Template plate document</td>
<td>*.sdt</td>
<td>File that already contains run parameters that are commonly used in plate documents, such as detectors, thermal cycler conditions, and so on. Streamlines the creation of the SDS document (*.sds) file.</td>
</tr>
</tbody>
</table>

### Example plate document setup
You can arrange the reactions in any well of the reaction plate, but you need to set up the plate document so that it corresponds exactly to the arrangement of the standards and unknown samples in the wells of the reaction plate. Table 8 shows one example of arranging reactions when running two Quantifiler® Kit assays on one 96-well plate:
- Wells A1 through D12 (gray) correspond to reactions using the Quantifiler® Human Kit
- Wells E1 through H12 (white) correspond to reactions using the Quantifiler® Y Kit

**Note:** For each Quantifiler® Kit assay, there are eight DNA quantification standards and two reactions for each standard. See “Prepare the DNA quantification standard” on page 51 for more information about the DNA quantification standards.
Chapter 2  Software Setup

Set up a plate document

Overview

Setting up a plate document involves:

1. Create a blank plate document (page 43)
2. Create detectors (page 43)
3. Copy detectors to the plate document (page 45)
4. Apply detectors for standards (page 45)
5. Apply detectors for unknown samples (page 46)

Table 8  Example arrangement of reactions with two kits

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Std 1</td>
<td>Std 1</td>
<td>Std 2</td>
<td>Std 2</td>
<td>Std 3</td>
<td>Std 3</td>
<td>Std 4</td>
<td>Std 4</td>
<td>Std 5</td>
<td>Std 5</td>
<td>Std 6</td>
<td>Std 6</td>
</tr>
<tr>
<td>B</td>
<td>Std 7</td>
<td>Std 7</td>
<td>Std 8</td>
<td>Std 8</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>C</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>D</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>E</td>
<td>Std 1</td>
<td>Std 1</td>
<td>Std 2</td>
<td>Std 2</td>
<td>Std 3</td>
<td>Std 3</td>
<td>Std 4</td>
<td>Std 4</td>
<td>Std 5</td>
<td>Std 5</td>
<td>Std 6</td>
<td>Std 6</td>
</tr>
<tr>
<td>F</td>
<td>Std 7</td>
<td>Std 7</td>
<td>Std 8</td>
<td>Std 8</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>G</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>H</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
</tbody>
</table>

Table 9 shows another example of arranging reactions when running two Quantifiler® Kits on one 96-well reaction plate if you are using repeat pipettors:

- Wells A1 through D6 (gray) correspond to reactions using the Quantifiler® Human Kit
- Wells A7 through H12 (white) correspond to reactions using the Quantifiler® Y Kit

For each Quantifiler® Kit assay, there are eight DNA quantification standards and two reactions for each standard. See “Prepare the DNA quantification standard” on page 51 for more information about the DNA quantification standards.

Table 9  Example arrangement of reactions using repeat pipettors

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Std 1</td>
<td>Std 1</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 1</td>
<td>Std 1</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>B</td>
<td>Std 2</td>
<td>Std 2</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 2</td>
<td>Std 2</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>C</td>
<td>Std 3</td>
<td>Std 3</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 3</td>
<td>Std 3</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>D</td>
<td>Std 4</td>
<td>Std 4</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 4</td>
<td>Std 4</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>E</td>
<td>Std 5</td>
<td>Std 5</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 5</td>
<td>Std 5</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>F</td>
<td>Std 6</td>
<td>Std 6</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 6</td>
<td>Std 6</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>G</td>
<td>Std 7</td>
<td>Std 7</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 7</td>
<td>Std 7</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>H</td>
<td>Std 8</td>
<td>Std 8</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>Std 8</td>
<td>Std 8</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
</tbody>
</table>

Set up a plate document
6. Apply detectors for unknown samples (page 46)
7. Set thermal cycler conditions (page 47)
8. Save the plate document (page 48)

**Create a blank plate document**

To create a blank plate document:

1. If the SDS software is not already started, select Start ▶ Programs ▶ Applied Biosystems ▶ SDS 2.0.
2. Select File ▶ New, complete the New Document dialog box, then click OK.

![New Document](image)

**Create detectors**

Before you set up the plate document, you need to create detectors in the SDS software for running Quantifiler® Kit assays. After the detectors are created, you do not need to create detectors for subsequent runs of Quantifiler® Kit assays and you can skip to “Copy detectors to the plate document” on page 45.

To create detectors:

1. With a new plate document open, select Tools ▶ Detector Manager.
2. Create a detector for the Quantifiler® Human kit:
   a. In the lower left part of the Detector Manager, click New, then complete the dialog box:
      ![Add Detector](image)
b. Click OK to return to the Detector Manager.

3. Create a detector for the Quantifiler® Y Human Male Kit:
   a. In the Detector Manager, click New and complete the dialog box:

   ![Add Detector Dialog](image)

   b. Click OK to return to the Detector Manager.

4. Create a detector for the IPC assay:
   a. In the Detector Manager, click New, then complete the Add Detector dialog box:

   ![Add Detector Dialog](image)

   b. Click OK to return to the Detector Manager.
**Copy detectors to the plate document**

To copy detectors to the plate document:

1. If the Detector Manager is not already open, select **Tools > Detector Manager**.
2. Select the Quantifiler® Human, Quantifiler® Y, and the IPC detectors by clicking them while pressing the **Ctrl** key.
   
   **Note:** If the detectors are not available, create them first (see page 43 for the procedure).
3. With the three detectors selected, click **Copy To Plate Document**.
4. Click **Done** to close the Detector Manager and return to the plate window.

**Apply detectors for standards**

You need to apply the detectors to the plate document for the wells on the reaction plate that contain DNA quantification standards. Repeat the procedure until you complete applying detector tasks, quantities, and sample names for all quantification standards.

**IMPORTANT!** Set up detectors for each quantity and for each kit separately. For example, set up detectors for Std. 1 for the Quantifiler® Human Kit first, and then for Std. 2 for the Quantifiler® Human Kit, and so on, until you finish setting up the detectors for all wells containing quantification standards.

1. In the plate grid, press the **Ctrl** key while you select the wells that correspond to a specific quantification standard for one kit.
2. Complete the Well Inspector:
   a. Select the Use boxes for the applicable detectors:
      - IPC
      - Quantifiler® Human or Quantifiler® Y
   b. For the Quantifiler® Human or Quantifiler® Y detector:
      - Click **Unknown** in the Task column, then select **Standard** from the drop-down list.
      - Select the Quantity field and enter the quantity of DNA in the well.

   **IMPORTANT!** Although you do not enter units for Quantity, you must use a consistent unit (for example, ng/μL) for all standard quantities. The units used for standard quantities defines the quantification units for analysis results.

   **Note:** Leave the IPC detector Task for standard reactions set to Unknown. Quantity values are not needed for IPC detectors.

   c. Enter the Sample Name (for example, Std. 1, Std. 2, and so on).
   d. Make sure that ROX is selected for the Passive Reference.
Chapter 2  Software Setup

Set up a plate document

For example:

<table>
<thead>
<tr>
<th>Use</th>
<th>Detector</th>
<th>Reporter</th>
<th>Task</th>
<th>Quantity</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>IPC</td>
<td>VIC</td>
<td>Unknown</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>Quantifier Human</td>
<td>FAM</td>
<td>Standard</td>
<td>5E1</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>Quantifier Y</td>
<td>FAM</td>
<td></td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

Task for IPC set to Unknown (default)

Apply detectors for unknown samples

You need to apply detectors to the plate document for the wells on the reaction plate that contain unknown samples.

**IMPORTANT!** If you run reactions for the Quantifiler® Human Kit and the Quantifiler® Y Kit on the same plate, apply detectors for unknown samples for each kit separately.

To apply detectors for unknown samples:

1. In the plate grid, press the Ctrl key and select the wells that contain unknown samples for one kit.
2. In the Well Inspector, select the Use boxes for the detectors in the selected wells:
   - IPC
   - Quantifier® Human or Quantifier® Y detector
   
   For example:

3. In the Well Inspector, make sure that ROX is selected for the Passive Reference.

Add sample names to unknown samples

Repeat this procedure to enter the names for all unknown samples.

1. In the plate grid, select a reaction well containing an unknown sample.
2. In the Well Inspector panel, enter a name in the Sample Name field.

**IMPORTANT!** Samples with identical sample names are treated as replicates by the SDS software. Results for replicate reactions are grouped together automatically for data analysis.
Set thermal cycler conditions

To set thermal cycler conditions:

1. In the plate window, select the **Instrument** tab.

2. Delete the Stage 1 hold step (50 °C for 2 minutes):
   a. Press the **Shift** key and click within the Stage 1 hold step.

   ![Press the Shift key and click within the Stage 1 hold step](image1)

   **Hold step is selected**

   b. After the hold step is selected, press the **Delete** key.

3. Make sure that the thermal profile appears as follows:

   ![Thermal profile](image2)

4. Set the Sample Volume to **25 μL** and make sure that the 9600 Emulation box is selected.
5. Selecting the 9600 Emulation box reduces the ramp rate.

6. Make sure that the default settings are kept on the remaining tabs:
   - Auto Increment
   - Ramp Rate
   - Data Collection

**Save the plate document**

Before running the reaction plate, save the plate document as an ABI Prism SDS Single Plate (*.sds) file.

**Note:** To save the document as a template, see “Set up a plate document template” on page 48.

To save the plate document:

1. Select **File > Save As**.
2. For Files of Type, select **ABI Prism SDS Single Plate (*.sds)**.
3. Navigate to where you want to save the plate document file.
4. In the File Name field, enter a name for the plate document.
5. Click **Save**.

**Set up a plate document template**

**Purpose**

A plate document template reduces the time required to set up a plate document. This section describes how to create an SDS Template Document (*.sdt) set up for running Quantifiler® Kit assays.

**Template settings**

In addition to plate document settings (assay and container), templates can contain:
   - Assay-specific detectors
   - Well assignments for quantification standards, with detectors, tasks, and quantity
   - Well assignments for unknown samples, with detectors and tasks
   - Instrument settings: thermal cycler conditions and reaction volume settings.
Create a plate document template

This procedure assumes that you have created the detectors for running reactions using the Quantifiler® Kits (page 43).

To create a plate document template:

1. If the SDS software is not already started, select Start ▶ Programs ▶ Applied Biosystems ▶ SDS 2.0.

2. Select File ▶ New, then complete the New Document dialog box:

![New Document Dialog Box]

3. Apply the desired template settings to the plate document:
   - Copy detectors (page 45)
   - Apply detectors for standards (page 45)
   - Apply detectors for unknown samples (page 46)
   - Set thermal cycler conditions (page 47)

4. Select File ▶ Save As and complete the Save As dialog box:
   a. For Files of Type, select ABI Prism SDS Template Document (*.sdt).
   b. Locate and select the Templates folder within the software folder:
      X:Program Files ▶ Applied Biosystems ▶ 7900HTSDS ▶ Templates, where X is the hard drive on which the SDS software is installed.
      
      Note: Saving the template file in the Templates folder makes it available in the Template drop-down list of the New Document dialog box (see step 2 in “Create a plate document template” on page 49).
   c. Enter a name for the template. For example, enter Quantifiler Template.
   d. Click Save.
Create a plate document from a template  

After you create a template, you can use it to create a plate document.

To create a plate document from a template:

1. If the SDS software is not already started, select **Start ▸ Programs ▸ Applied Biosystems ▸ SDS 2.0**.

2. Select **File ▸ New** and in the New Document dialog box and make the following selections:
   - For Assay, select **Absolute Quantitation**.
   - For Container, select **96-Well Clear Plate**.
   - For Template, select an appropriate template from the list.
   
   **Note:** If the template is not available in the list, click **Browse** to locate and select an appropriate template.

3. Complete the plate document setup:
   - Copy detectors (page 45)
   - Apply detectors for standards (page 45)
   - Apply detectors for unknown samples (page 46)
   - Set thermal cycler conditions (page 47)
   
   **Note:** The tasks that you perform vary according to which settings were defined in the template.

4. Save the plate document (page 48).
   
   **Note:** For Files of Type, select **ABI Prism SDS Single Plate (*.sds)**.
Prepare the DNA quantification standard

Required materials
- Pipettors
- Pipette tips
- Quantifiler® Human DNA Standard
  Note: The same standard can be used for both Quantifiler® Kits.
- T<sub>10E0.1</sub> buffer:
  - 10 mM Tris-HCl (pH 8.0)
  - 0.1 mM Na<sub>2</sub>EDTA
  - 20 μg/mL glycogen (optional)
  Note: If you use T<sub>10E0.1</sub> buffer with glycogen, you can store the DNA quantification standards for up to 2 weeks at 2 to 8 °C.

Guidelines for calculating the standards dilution series
The standard dilution series example shown in Table 10 is suitable for general use. We recommend:
- Three-fold dilution series with eight concentration points in the standard series for each assay
- Minimum input volume of 10 μL DNA for dilutions (to ensure accuracy of pipetting)

Standards dilution series example
Table 10 shows an example of one standards dilution series with the concentrations ranging from 50 ng/μL (Std. 1) to 0.023 ng/μL, or 23 pg/μL (Std. 8). A sample at the lowest concentration (2 μL per reaction) contains on average 14 to 16 copies of a diploid single-copy locus and 7 to 8 copies of a haploid single-copy locus.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Concentration (ng/μL)</th>
<th>Example Amounts</th>
<th>Minimum Amounts</th>
<th>Dilution Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Std. 1</td>
<td>50,000</td>
<td>50 μL [200 ng/μL stock] + 150 μL T&lt;sub&gt;10E0.1&lt;/sub&gt;/glycogen buffer</td>
<td>10 μL [200 ng/μL stock] + 30 μL T&lt;sub&gt;10E0.1&lt;/sub&gt; buffer</td>
<td>4X</td>
</tr>
<tr>
<td>Std. 2</td>
<td>16,700</td>
<td>50 μL [Std. 1] + 100 μL T&lt;sub&gt;10E0.1&lt;/sub&gt;/glycogen buffer</td>
<td>10 μL [Std. 1] + 20 μL T&lt;sub&gt;10E0.1&lt;/sub&gt; buffer</td>
<td>3X</td>
</tr>
</tbody>
</table>
Prepare the DNA quantification standard

While preparing the standards, keep in mind that:
- DNA quantification standards are critical for accurate analysis of run data
- Any mistakes or inaccuracies in making the dilutions directly affect the quality of results
- The quality of pipettors and tips and the care used in measuring and mixing dilutions affect accuracy

Prepare the DNA quantification standards

If you use T10E0.1 Buffer:
- With glycogen, you can store the prepared DNA quantification standards for up to 2 weeks at 2 to 8 °C.
- Without glycogen, long-term stability of the prepared DNA quantification standards may not be assured

To prepare the DNA quantification standards dilution series:
1. Label eight microcentrifuge tubes: Std. 1, Std. 2, Std. 3, and so on.
2. Dispense the required amount of diluent (T10E0.1 Buffer with or without glycogen) to each tube.
3. Prepare Std. 1:
   a. Vortex the Quantifiler® Human DNA Standard 3 to 5 seconds.
   b. Using a new pipette tip, add the calculated amount of Quantifiler® Human DNA Standard to the tube for Std. 1.
   c. Mix the dilution thoroughly.
4. Prepare Std. 2 through 8:
   a. Using a new pipette tip, add the calculated amount of the prepared standard to the tube for the next standard.
   b. Mix the standard thoroughly.
   c. Repeat a. and b. until you complete the dilution series.
Prepare the reactions

Required materials

- Quantifiler® Human Primer Mix or Quantifiler® Y Human Male Primer Mix
- Quantifiler® PCR Reaction Mix
- 10-mL polypropylene tube
- 96-well reaction plate
- Extracted DNA samples
- DNA quantification standards dilutions series
- $T_{10E0.1}$ Buffer (with or without glycogen for negative controls)
- Optical Adhesive Cover

Prepare the reactions

While preparing the reactions, keep the 96-well reaction plate in its base and do not place it on the counter.

To prepare the reactions:

1. Calculate the volume of each component needed to prepare the reactions, using the table below.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume Per Reaction (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human Primer Mix or Quantifiler® Y Human Male Primer Mix</td>
<td>10.5</td>
</tr>
<tr>
<td>Quantifiler® PCR Reaction Mix</td>
<td>12.5</td>
</tr>
</tbody>
</table>

Note: Include additional reactions in your calculations to provide excess volume for the loss that occurs during reagent transfers.

2. Prepare the reagents:

3. Thaw the primer mix completely, then vortex 3 to 5 seconds and centrifuge briefly before opening the tube.

4. Swirl the Quantifiler® PCR Reaction Mix gently before using. Do not vortex it.
   - Pipette the required volumes of components into an appropriately sized polypropylene tube.
   - Vortex the PCR mix 3 to 5 seconds, then centrifuge briefly.

5. Dispense 23 µL of the PCR mix into each reaction well.

6. Add 2 µL of sample, standard, or control to the appropriate wells. For plate setup examples, see page 28, page 29, page 42, and page 42.
   
   Note: We recommends running duplicates of the eight DNA quantification standards for each assay and on each reaction plate (see page 52).

7. Seal the reaction plate with the Optical Adhesive Cover.

8. Centrifuge the plate at 3000 rpm for about 20 seconds in a tabletop centrifuge with plate holders to remove any bubbles.
   
   Note: If a tabletop centrifuge with 96-well plate adapters is not available, this step can be omitted.
9. If you are using a 7000 or 7900HT instrument, place the compression pad over the Optical Adhesive Cover with the gray side down and the brown side up and with the holes positioned directly over the reaction wells.

**IMPORTANT!** Do not use a compression pad if you are using a 7500 instrument.

**Run the reactions**

**Before you run the reactions**

Before you run the reactions, make sure that you have:

- Powered on the SDS instrument, computer, and software:
  - For 7000 SDS setup procedures, see page 26
  - For 7900HT SDS setup procedures, see page 40
- Set up a plate document for the run:
  - For 7000 SDS software procedures, see page 29
  - For 7900HT SDS software procedures, see page 42

**Run the plate on the 7000 SDS**

To run the plate on the 7000 SDS:

1. Lift the handle at the bottom of the door on the front of the instrument until the door is raised completely. Gently push the carriage back until it stops and locks into place.

2. Position the plate in the instrument thermal block so that:
   - Well A1 is in the upper-left corner
   - The notched corner of the plate is in the upper-right corner
3. Gently push then release the carriage to unlatch it. The carriage automatically slides forward into position over the sample plate.

4. After the door moves to the front, pull the handle down into place to close the cover.

**CAUTION!** Do not pull the door handle to move the carriage forward. This may cause serious damage to the door or the door mechanism.

5. In the SDS software, open the plate document that you set up for the run.

6. Select the Instrument tab, then click Start.

---

**Run the plate on the 7900HT SDS**

To run the plate on the 7900HT SDS:

1. In the SDS software, select the Instrument tab for the plate document.

2. In the Real-Time tab, click Open/Close to rotate the instrument tray to the OUT position.

3. Place the plate in the instrument tray so that:
   - Well A1 is in the upper-left corner
   - The notched corner is in the upper-right corner

4. Click Start to rotate the instrument tray to the IN position and to start the run.

**Note:** The instrument may pause to allow the heated cover to heat to the appropriate temperature before beginning the run.

The SDS software collects and saves the run data and the Real-Time tab displays the instrument status and run progress.

5. After the run is complete, remove the plate from the instrument:
   a. Click Open/Close in the Instrument tab of the plate document that is open and connected to the 7900HT instrument. The instrument tray rotates to the OUT position.
   b. Remove the plate from the instrument.
   c. Click Open/Close in the Instrument tab to rotate the instrument tray to the IN position.
Run the reactions
Data Analysis and Results

- Section 4.1 7000 SDS Data Analysis ........................................ 58
  Analyze the plate document .................................................. 58
  View results ........................................................................ 58
- Section 4.2 7900HT SDS Data Analysis .................................... 61
  Analyze the plate document .................................................. 61
  View results ........................................................................ 61
Section 4.1 7000 SDS Data Analysis

Analyze the plate document

Analyze a run after it is complete and reanalyze after you make any changes to the plate document, such as sample names.

To analyze a plate document:

1. Open the plate document to analyze.
2. Verify the analysis settings:
   a. Select Analysis ▶ Analysis Settings to open the Analysis Settings dialog box.
   b. Verify that the settings are as shown below, then click OK.

   ![Analysis Settings Dialog Box]

   **IMPORTANT!** If the analysis settings differ from those shown here, change them to match the settings before clicking OK.

3. Select Analysis ▶ Analyze.

View results

Overview

Viewing the results of data analysis can involve one or more of the following:

- View the standard curve (page 58)
- View the amplification plot (page 59)
- View the report (page 59)
- Print or export the report (page 60)

View the standard curve

For information about interpreting and troubleshooting the standard curve, see “Examine the standard curve” on page 66 and “Troubleshoot the standard curve” on page 68.
To view the standard curve:

1. In the Results tab, select the **Standard Curve** tab.
2. In the Detector drop-down list, select the detector that corresponds to the kit that you are using:
   - **Quantifiler Human** or
   - **Quantifiler Y**
3. View the C_T values for the quantification standard reactions and the calculated regression line, slope, y-intercept, and R^2 values.

**Amplification plot results**

The amplification plot can display one of the following:

- Plot of normalized reporter signal (R_n) versus cycle number for each reaction
- C_T versus well position on the assay plate

For more information about the amplification plot, see “Real-time data analysis” on page 18.

**View the amplification plot**

For troubleshooting information, see “Troubleshoot amplification plots” on page 73.

To view the amplification plot:

1. In the Results tab, select the **Amplification Plot** tab.
2. In the Detector drop-down list, select a detector:
   - **Quantifiler Human** or **Quantifiler Y**
   - **IPC**
3. Select the appropriate samples in the table below the amplification plot.
4. Make sure that the Threshold is set to **0.20**, the default setting.
   - **Note:** If you move the threshold bar, it changes from green to red to indicate reanalysis is needed. After reanalysis, it changes from red to green.

**View the report**

The report summarizes the quantity of DNA present in the samples. For information about the quantities reported, see “Assess quantity” on page 77.

To view the report:

1. In the analyzed plate document, select the Results tab, then select the Report tab.
2. Select the reactions in the 96-well plate representation below the report to display the results in the report.
3. View the Qty column to determine the quantity of DNA in each sample.
   - **Note:** Quantities are calculated only if quantification standards were run and set up correctly in the software. Otherwise, only C_T values are shown.
For more information about exporting data, see the ABI Prism® 7000 Sequence Detection System User Guide (Pub. no. 4330228).

To print or export the report:

1. In the Report tab of the Results window, select Tools >> Report Settings, then set up how the report is printed and exported:

2. Do one of the following:
   - Select File >> Print to print the report.
   - Select File >> Export to export the report as tab-delimited text.

Note: You can later open the exported file using spreadsheet software.
Section 4.2 7900HT SDS Data Analysis

Analyze the plate document

Analyze a run after it is complete and reanalyze the run:

- Each time that you open a plate document to convert the saved raw data into analyzed data
- After you make changes to the plate document, such as sample names

To analyze the plate document:

1. Open the plate document to analyze.

2. Verify the analysis settings:
   a. Select Analysis ▶ Analysis Settings to open the Analysis Settings dialog box.
   b. Verify that the settings are as shown below, then click OK:

   ![Analysis Settings Dialog Box]

   **IMPORTANT!** If the analysis settings differ from those shown here, change them to match the settings before clicking OK.

3. Select Analysis ▶ Analyze for the software to convert the raw data to analyzed data.

4. Select the Results tab to view the results.

View results

Overview

Viewing the results of data analysis can involve one or more of the following:

- View the standard curve (page 62)
- View the amplification plot (page 62)
- View the results table (page 63)
- Print the results (page 63)
- Export the results (page 63)
View the standard curve

For information about interpreting and troubleshooting the standard curve, see “Examine the standard curve” on page 66 and “Troubleshoot the standard curve” on page 68.

To view the standard curve:

1. In the Results tab, select the Standard Curve tab.
2. In the Detector drop-down list, select the detector that corresponds to the kit that you are using:
   - Quantifiler Human or Quantifiler Y
3. View the $C_T$ values for the quantification standard reactions and the calculated regression line, slope, y-intercept, and $R^2$ values.

Amplification plot results

The amplification plot can display one of the following:

- Plot of normalized reporter signal ($R_n$) versus cycle number for each reaction
- $C_T$ versus well position on the assay plate

For more information about the amplification plot, see “Real-time data analysis” on page 18.

View the amplification plot

For troubleshooting information, see “Troubleshoot amplification plots” on page 73.

To view the amplification plot:

1. In the Results tab, select the Amplification Plot tab.
2. In the Detector drop-down list, select a detector:
   - Quantifiler Human or Quantifiler Y
   - IPC
3. Select the appropriate samples in the table below the amplification plot.
4. Make sure that the Threshold is set to 0.20, the default setting.

   Note: If you move the threshold bar, it changes from green to red to indicate reanalysis is needed. After reanalysis, it changes from red to green.

Results table

The results table displays:

- Well position of samples
- Sample names
- Detector assignments
- Task assignments
- $C_T$ values
- Quantity
- Mean and standard deviation for $C_T$ values and Quantity, if replicate groups were defined in assay setup
View the results table

View the Qty column to determine the quantity of DNA present in each sample.

**Note:** Units for calculated quantities are not displayed but are the same as those specified for the quantification standards when you set up the plate document.

**Note:** Quantities are calculated only if quantification standards were run and set up correctly in the software. Otherwise, only C_T values are shown.

For more information about the quantities reported, see “Assess quantity” on page 77.

Print the results

To print the results:

1. Select **File ▶ Print** Report.
2. Select the data to include in the report by selecting the corresponding boxes for:
   - Document Information
   - Thermal Cycler Conditions
   - Detector Information
   - Well Status Summary
   - Raw Data Plot
   - Multicomponent Data Plot
   - Amplification Plot
3. Click **Page Setup**, then select:
   - Header/footer information and placement
   - Layout orientation and size
4. Click **Print** to print the report.

Export the results

You can export the results in tab-delimited (*.txt) format and later open the exported files using spreadsheet software.

To export the results:

1. Select **File ▶ Export**.
2. Select the results to export:
   - Setup Table
   - Results Table
   - Multicomponent
   - Clipped
3. Select whether you want to export data from all wells or selected wells.
4. Select the SDS format of data to export.
5. Select **Group by replicates** if you want the replicates to be grouped together in the exported results.
6. Locate, then select the folder where you want to save the exported results file.
7. Enter the File Name, then click **Export**.
Check analysis settings

The validity of the results requires correct analysis settings.

To check analysis settings on the 7000 SDS:

1. If the SDS software is not already started, select Start ▶ Programs ▶ ABI Prism 7000 ▶ ABI Prism 7000 SDS Software.
2. Select File ▶ Open.
3. Locate the plate document for the assay run of interest, select it, then click Open.
4. Select Analysis ▶ Analysis Settings.
5. For all detectors, confirm that the settings are as shown below:

![Analysis Settings](image)

6. If the analysis settings differ from those shown in step 5:
   a. Change the settings to match those in step 5.
   b. Click Apply.
   c. Click OK & Reanalyze to close the dialog box and reanalyze the plate document.
   d. View the results using Chapter 4, “Data Analysis and Results”.

7000 SDS Software
Check analysis settings on the 7900HT SDS

1. If the SDS software is not already started, select Start ➤ Programs ➤ Applied Biosystems ➤ SDS 2.0.

2. Select File ➤ Open.

3. Locate the plate document for the assay run of interest, select it, then click Open.

4. Select Analysis ➤ Analysis Settings and confirm that the settings are as shown below:

5. If the analysis settings differ from those shown in step 4:
   a. Change the settings to match those in step 4.
   b. Click OK.
   c. Select Analysis ➤ Analyze for the software to reanalyze the data.
   d. View the results using Chapter 4, "Data Analysis and Results".

Examine the standard curve

Examine the standard curve results to evaluate the quality of the results from the quantification standard reactions.

About standard curve results

The standard curve is a graph of the $C_T$ of quantification standard reactions plotted against the starting quantity of the standards. The software calculates the regression line by calculating the best fit with the quantification standard data points. The regression line formula has the form:

$$C_T = m \log (Qty) + b$$

where $m$ is the slope, $b$ is the y-intercept, and Qty is the starting DNA quantity. The values associated with the regression analysis can be interpreted as follows:

- **R² value** – Measure of the closeness of fit between the standard curve regression line and the individual $C_T$ data points of quantification standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points.
- Regression coefficients:
  - **Slope** – Indicates the PCR amplification efficiency for the assay. A slope of $-3.3$ indicates 100% amplification efficiency.
  - **Y-intercept** – Indicates the expected $C_T$ value for a sample with Qty = 1 (for example, 1 ng/μL)
Chapter 5  Interpretation of Results
Examine the standard curve

R² value
An R² value ≥ 0.99 indicates a close fit between the standard curve regression line and the individual Cₜ data points of quantification standard reactions.

If the R² value is <0.98 check the following:
- Quantity values entered for quantification standards in the Well Inspector during plate document setup
- Making of serial dilutions of quantification standards
- Loading of reactions for quantification standards
- Failure of reactions containing quantification standards
- Cₜ value for Std. 8 of the DNA quantification standard (23 pg/μL), if using the Cₜ

R² value < 0.98 for Quantifiler® Y Kit only
If the R² value is <0.98 for the Quantifiler® Y Kit only, you may choose to omit Std. 8 of the DNA quantification standard (23 pg/μL) from analysis.

At the lowest concentration point, there are only 7 to 8 copies per 2 μL reaction of the haploid target locus for the Quantifiler® Y Kit. Because of stochastic effects when using the lowest concentration point with Quantifiler® Y Kits, the Cₜ values are more variable at the lowest concentration point and may affect the closeness of fit between the standard curve regression line and the individual data points of the quantification standard.

To omit Std. 8 from analysis (for Quantifiler® Y Kits only):
1. Select the wells in the plate document that correspond to Std. 8 and open the Well Inspector.
2. Change the Task assignment for the Quantifiler® Y detector from Standard to Unknown.
3. Reanalyze the plate to incorporate the change.

Slope
A slope close to −3.3 indicates optimal, 100% PCR amplification efficiency.

Table 11  Range and average of standard curve slope values

<table>
<thead>
<tr>
<th>Kit</th>
<th>Typical Slope (range)</th>
<th>Average Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human</td>
<td>−2.9 to −3.3</td>
<td>−3.1</td>
</tr>
<tr>
<td>Quantifiler® Y</td>
<td>−3.0 to −3.6</td>
<td>−3.3</td>
</tr>
</tbody>
</table>

If the slope varies beyond the typical range indicated in Table 11, check the following:
- Assay setup
- Software setup
- Reagents
- Instrument
## Troubleshoot the standard curve

### Table 12  Troubleshooting the standard curve

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
</table>
| Slope for the standard curve differs significantly from −3.33 or R² value significantly less than 0.98 to 0.99 | When applying detectors for standards, the Task and Quantity were applied to the wrong detector (see “Example 1” on page 69). | 1. From the plate document, double-click a well containing a DNA quantification standard to view the Well Inspector.  
2. Verify that the Task and Quantity were applied to the correct detector and reanalyze. |
|                                                                             | When applying detectors for the standards, the incorrect Quantity was entered (see “Example 2” on page 69). | 1. From the plate document, double-click a well containing a DNA quantification standard to view the Well Inspector.  
2. Verify that the correct Quantity was entered and reanalyze. |
|                                                                             | Stochastic effects when using the lowest concentration point with the Quantifiler® Y Kit. | Omit Std. 8 of the DNA quantification standard (23 pg/µL) from analysis. |

| At each concentration in the standard curve:                             | The same detector was applied for the Quantifiler® Human Kit standard reactions and for the Quantifiler® Y Kit standard reactions (see “Example 3” on page 70). | 1. From the plate document, double-click a well containing a DNA quantification standard to view the Well Inspector.  
2. Verify that the correct detector is in use and that the Task and Quantity were applied to the correct detector and reanalyze. |
| • There are four replicates                                               | • There is a large difference in C<sub>T</sub> between the replicates          |                                                                                     |
| • Note: This observation applies only when Quantifiler® Human Kit reactions and Quantifiler® Y Kit reactions are run together on the same reaction plate. |

The examples shown in the following sections can be caused by errors made in applying the detectors for standards when setting up the plate document. For instructions on how to apply the detectors for standards, see:

- Page 32 (7000 SDS)
- Page 45 (7900HT SDS)

**Note:** The standard curves shown in these examples are not optimal and should not be used.
Example 1 Observation

Almost all of the $C_T$ values for the DNA quantification standard reactions lie outside of the standard curve and form a straight horizontal line.

Possible Cause

When applying detectors for the standards, the Task and Quantity were applied to the IPC detector instead of to the Quantifiler® Human detector.

Example 2 Observation

One point lies outside of the standard curve.
Possible cause

When applying detectors for the standards, the incorrect Quantity was entered. In the example shown above, 0.062 was entered for the Quantity instead of 0.62.

Example 3 Observation

At each concentration in the standard curve:
- There are four replicates
- There is a large difference in the CT between the replicates

Possible Cause

The Quantifiler® Human Kit assay and the Quantifiler® Y Kit assay were performed on the same reaction plate and when applying detectors for standards, the same detector was applied for Quantifiler® Human kit standard reactions and for the Quantifiler® Y Kit standard reactions.

Using the Internal PCR Control system

Purpose

Use the Internal PCR Control (IPC) system to distinguish between true negative sample results and reactions affected by:
- The presence of PCR inhibitors
- Assay setup
- A chemistry or instrument failure
Components

The following components of the IPC system are present in the Quantifiler® PCR mix:
- Synthetic DNA template
- Primers that hybridize specifically to the synthetic DNA template
- Probe labeled with VIC® dye

Interpret IPC results

In the amplification plot window of the SDS software, observe amplification of the FAM™ dye (Quantifiler® Human detector or Quantifiler® Y detector) and the VIC® dye (IPC detector), then use Table 13 to interpret the IPC results.

Table 13 Interpreting IPC amplification results

<table>
<thead>
<tr>
<th>Quantifiler® Human or Quantifiler® Y (FAM Dye)</th>
<th>IPC (VIC Dye)</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>No amplification</td>
<td>Amplification</td>
<td>True negative</td>
</tr>
<tr>
<td>No amplification</td>
<td>No amplification</td>
<td>Invalid result</td>
</tr>
<tr>
<td>Amplification (low CT and high ΔRn)</td>
<td>No amplification</td>
<td>Disregard IPC result</td>
</tr>
<tr>
<td>Amplification (high CT and low ΔRn)</td>
<td>No amplification</td>
<td>Partial PCR inhibition</td>
</tr>
</tbody>
</table>

Note: Positive amplification is when the CT value for the detector is <40. Because samples contain unknown amounts of DNA, a large range of CT values is possible. Because the IPC system template DNA is added to the reaction at a fixed concentration, the CT VIC should range from 20 to 30.

True negative results

With a true negative result:
- FAM™ dye signal indicates that the human-specific target failed to amplify
- VIC® dye signal (CT VIC® between 20 and 30) indicates that the IPC target was amplified; so, the PCR was not inhibited

Invalid IPC results

If the human-specific target and the IPC target failed to amplify, it is not possible to distinguish between the absence of DNA and PCR inhibition.

Disregard IPC results

With extremely high concentrations of human genomic DNA (>10 ng/μL), competition between the human-specific and IPC PCR reactions appears to suppress IPC amplification for that sample. If the target amplifies with low CT and high ΔRn results, it is unlikely that PCR inhibitors are present. In these cases, appearance of suppression or failure of IPC amplification can be disregarded.

Partial PCR inhibition

Weak amplification (high CT value and low ΔRn value) of the human target and no amplification of the IPC may indicate partial PCR inhibition in the sample.

Determine the normal range for IPC

To determine the normal range of CT values for the IPC, view the VIC® dye signal in the amplification plots for the quantification standards. If the assays were set up properly and the buffer used to dilute the quantification standards was free of PCR inhibitors, the reactions should show normal IPC amplification across a broad range of input DNA.
Evaluate PCR inhibition

If the IPC amplification for certain samples appears reduced relative to IPC amplification for quantification standards, the decreased IPC amplification may be interpreted as partial PCR inhibition. The IPC results can help you decide the next step:

- Proceed directly to an STR assay of the sample
- Repeat the DNA extraction from the sample
- Perform additional cleanup of the sample
## Troubleshoot amplification plots

### Table 14 Troubleshooting amplification plots

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
</table>
| $\Delta R_n$ and $C_T$ values inconsistent with replicates | Evaporation of reaction mixture from some wells because the Optical Adhesive Cover was not sealed to the reaction plate properly or the compression pad was not used during the run.                                                                                                                                                                                    | Confirm the cause:  
1. Select the Component tab.  
Affected wells should generate significantly less fluorescence compared to unaffected replicates.  
2. Check the amount of solution in each well of the reaction plate.  
Wells affected by evaporation should contain less solution compared to unaffected wells and should correspond with the inconsistent results. For subsequent runs, make sure that the Optical Adhesive Cover is sealed to the reaction plate properly and that the compression pad is used. |
| $\Delta R_n$ and $C_T$ values inconsistent with replicates | Incorrect volume of Quantifiler® PCR Reaction Mix added to some reactions                                                                                                                                                                                                                                                                  | Confirm the cause:  
1. Select the Component tab.  
Affected wells should generate significantly different amounts of fluorescence compared to unaffected replicates.  
2. Select the Spectra tab.  
Wells with the incorrect volume of Quantifiler® PCR Reaction Mix should generate significantly different amounts of fluorescence compared to unaffected wells. |
### Chapter 5

#### Interpretation of Results

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jagged amplification plots</td>
<td>Weak lamp or improper replacement</td>
<td>Replace the lamp or make sure that the lamp was replaced properly.</td>
</tr>
<tr>
<td>Baseline spikes with certain reactions and normal amplification with other reactions</td>
<td>Mechanical or optical misalignment</td>
<td>1. Localize the wells that contain baseline spikes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Run the TaqMan® RNase P Instrument Verification Plate (Cat. no. 4310982).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Perform the instrument function tests.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If a function test fails, contact your Life Technologies Service Representative.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If all functional tests pass, the reaction plate or the door of the instrument may not have been aligned properly during the run.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> See your instrument user guide for instructions on how to perform instrument function tests.</td>
</tr>
</tbody>
</table>
### Chapter 5
### Interpretation of Results

#### Troubleshoot amplification plots

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
</table>
| Abnormal amplification plots in one column of reactions | Uncalibrated pure dyes, damage to the lens, or dust on the filters and/or mirror | If the pure dyes are not calibrated, run the pure dyes and recalibrate. 
**Note:** See your instrument user guide for instructions on how to run pure dyes and recalibrate. |
| No defined amplification plots | Incorrect detector selected on the amplification plot or incorrect detector applied to the reactions when setting up the plate document | 1. Make sure that the correct detector is selected on the amplification plot.
2. If the amplification plots are still not defined:
   a. From the plate document, double-click a well to view the Well Inspector.
   b. Verify that the detector settings are correct and reanalyze. |
| Abnormal $\Delta R_n$ values and some negative $R_n$ values | Incorrect passive reference was selected when setting up the plate document | Confirm the diagnosis:
1. From the plate document, double-click a well to view the Well Inspector.
2. Observe which Passive Reference is selected.
**Note:** ROX™ should be selected as the Passive Reference. |
### Troubleshoot amplification plots

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reactions in rows B, C, and D show poor amplification and reactions in the rows E, F, and G show good amplification</td>
<td>Instrument door was not aligned properly on the reaction plate</td>
<td>1. Localize the wells that show poor amplification.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Run the TaqMan® RNase P Instrument Verification Plate (Cat. no. 4310982).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Check the calibration of the regions of interest (ROI).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Perform the instrument function tests.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If a function test fails, contact your Life Technologies Service Representative.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If all functional tests pass, the reaction plate or the door of the instrument may not have been aligned properly during the run.</td>
</tr>
</tbody>
</table>

**Note:** See your instrument user guide for instructions on how to check ROI calibration and to perform instrument function tests.
Assess quantity

Purpose
After viewing the results and assessing the quality of the results, the analyst should determine whether sufficient DNA is present to proceed with a short tandem repeat (STR) assay.

Assay sensitivity
Quantifiler® Kit assays can detect < 23 pg/μL of human genomic DNA in samples. For samples loaded at 2.0 μL per reaction, this concentration corresponds to < 13 copies of the Quantifiler® Human target DNA and < 7 copies of the Quantifiler® Y target locus (Y chromosome loci are haploid).

Stochastic effects
In the 23-pg/μL concentration range, stochastic effects, or the statistical effect of sampling low-copy loci, may cause significant variability in assay results.

Validity
The detection and quantification of low-copy DNA samples with the Quantifiler® Kits is valid. However, the amounts present in the sample may be below the working range of certain genotyping methods.

If insufficient DNA is present
If the results from Quantifiler® Kit reactions indicate that insufficient DNA is present to perform an STR assay, the analyst may decide to:
- Extract the DNA again, then repeat the test with the Quantifiler® Kit before performing STR analysis
- Concentrate the sample, then repeat the test with the Quantifiler® Kit before performing STR analysis
Chapter 5  Interpretation of Results

Assess quantity
Data Analysis and Results

- Overview ................................................. 80
- Section 6.1 ABI PRISM® 7000 Sequence Detection System Validation (SDS Software v1.0) ............................................. 81
  Precision .................................................. 81
  Reproducibility ........................................... 83
  Specificity with a Human DNA Panel ............................. 85
  Specificity with a Non-Human Panel ............................... 86
  Specificity with a Bacterial Pools Panel ......................... 88
  Sensitivity ............................................... 89
  Stability .................................................. 90
  Mixture Studies ........................................... 93
  Degraded DNA Studies ...................................... 94
  Comparisons with other methods .................................. 97
  Comparison with A260 and Quantiblot® Kit .......................... 98
  Comparison with A260 and dye intercalation ...................... 100
  Assay background ....................................... 102
- Section 6.2 Applied Biosystems® 7900HT Real-Time PCR System Validation (SDS Software v2.0) ............................................. 104
  Precision (7900HT SDS) ................................... 104
  Mixture Studies (7900HT SDS) ................................ 105
  Comparisons with other methods (7900HT SDS) ................. 107
  Case type studies ........................................ 109
  Experiment ............................................... 109
  Results .................................................... 109
- Section 6.3 Casework Sample Analysis ............................. 109
  Case type studies ........................................ 109
  Experiment ............................................... 109
  Results .................................................... 109
- Section 6.4 Applied Biosystems® 7500 Real-Time PCR System Validation (SDS Software v1.2.3) ............................................. 113
  Overview .................................................. 113
  Materials and methods ...................................... 113
  Experimental setup ........................................ 114
  Data collection .......................................... 115
  Data analysis ............................................. 115
Overview

About this chapter

This chapter provides results of the validation experiments performed by Life Technologies using the Quantifiler® Human DNA Quantification Kit (Quantifiler® Human Kit) and the Quantifiler® Y Human Male DNA Quantification Kit (Quantifiler® Y Kit).

Importance of validation

Although the Quantifiler® Kits are not DNA genotyping assays, they are intended for use before performing genotyping assays such as the AmpFISTR® PCR Amplification kits (For Forensic or Paternity Use Only). By testing the procedure with samples commonly encountered in forensic and parentage laboratories, the validation process clarifies attributes and limitations that are critical for sound data interpretation in casework.

Experiments

Experiments to evaluate the performance of the Quantifiler® Kits were performed at Life Technologies, according to the DNA Advisory Board (DAB) Quality Assurance Standards For Forensic DNA Testing Laboratories (DAB, 1998). These DAB standards describe the quality assurance requirements that a laboratory should follow to ensure the quality and integrity of the data and competency of the laboratory. The DAB defines a laboratory as a facility in which forensic DNA testing is performed. Additional validation was performed according to guidelines from the Scientific Working Group on DNA Analysis Methods (SWGDAM).

The experiments focused on kit performance parameters relevant to the intended use of the kits as human-specific DNA quantification assays and as a part of a forensic DNA genotyping procedure.

Each laboratory using the Quantifiler® Human DNA Quantification Kit or the Quantifiler® Y Human Male DNA Quantification Kit should perform appropriate validation studies.
Section 6.1 ABI PRISM® 7000 Sequence Detection System Validation (SDS Software v1.0)

Precision

The precision of the Quantifiler® Human Kit and the Quantifiler® Y Kit was tested by performing runs on different instruments and on different days.

Experiment

One set of eight serial dilutions of the Quantifiler® Human DNA Standard was prepared. The dilutions ranged from 50 ng/μL to 23 pg/μL in three-fold increments.

Three different reaction plates were prepared and each plate contained duplicate reactions of the dilutions using the Quantifiler® Human and Y Human Male DNA Quantification Kits.

The three plates were run on three different 7000 SDS instruments, using standard thermal cycler conditions for the Quantifiler® Kits. The multiple runs were performed on two different days, using the same three 7000 SDS instruments.

The \( C_T \) FAM values were recorded and the means and standard deviations of the \( C_T \) FAM values were calculated for each of the eight dilutions using the Quantifiler® Human and Y Human Male DNA Quantification Kits.

Results

Table 15 shows the means and standard deviations of the \( C_T \) FAM values calculated for all 12 reactions of each quantification standard dilution for the Quantifiler® Human and Y Human Male DNA Quantification Kits.

Table 15  Precision: \( C_T \) values

<table>
<thead>
<tr>
<th>Quantification Standard Dilution (ng/μL)</th>
<th>Quantifiler® Human Kit</th>
<th>Quantifiler® Y Kit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>( C_T ) (Mean)</td>
<td>Standard Deviation</td>
</tr>
<tr>
<td>50</td>
<td>23.09</td>
<td>0.10</td>
</tr>
<tr>
<td>16.7</td>
<td>24.64</td>
<td>0.17</td>
</tr>
<tr>
<td>5.56</td>
<td>26.19</td>
<td>0.16</td>
</tr>
<tr>
<td>1.85</td>
<td>27.67</td>
<td>0.17</td>
</tr>
<tr>
<td>0.62</td>
<td>29.09</td>
<td>0.17</td>
</tr>
<tr>
<td>0.21</td>
<td>30.31</td>
<td>0.19</td>
</tr>
<tr>
<td>0.068</td>
<td>31.90</td>
<td>0.28</td>
</tr>
<tr>
<td>0.023</td>
<td>33.45</td>
<td>0.48</td>
</tr>
</tbody>
</table>

Figure 10 and Figure 11 show the \( C_T \) FAM results for all 8 quantification standard dilutions reactions using the Quantifiler® Human Kit and the Quantifiler® Y Kit.
The data show that at lower DNA concentrations, the $C_T$ values increased and the standard deviation increased, most likely because of stochastic effects.

For each sample, the $C_T$ values obtained using the Quantifiler® Human Kit are lower than those obtained using the Quantifiler® Y Kit because there are two copies of the autosomal human target locus and only one copy of the Y chromosome target locus.

The $C_T$ values do not vary significantly from run to run or from instrument to instrument. The $C_T$ value from one sample run on three different 7000 instruments varies with an average standard deviation of 0.3. Systematic differences between instruments, which are normally insignificant, are not expected to affect final sample quantification results because, when samples and quantification standards are run on the same plate and instrument, the $C_T$ values are affected equally.
Reproducibility

Six different human DNA samples were tested for reproducibility of the quantification results.

Table 16 Human DNA samples tested for reproducibility

<table>
<thead>
<tr>
<th>DNA</th>
<th>Sex</th>
<th>Extraction Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>007</td>
<td>Male</td>
<td>Blood</td>
</tr>
<tr>
<td>9948</td>
<td>Male</td>
<td>Cell line</td>
</tr>
<tr>
<td>Human genomic</td>
<td>Male</td>
<td>Blood</td>
</tr>
<tr>
<td>Raji [Lot 1]</td>
<td>Male</td>
<td>Cell line</td>
</tr>
<tr>
<td>Raji [Lot 2]</td>
<td>Male</td>
<td>Cell line</td>
</tr>
<tr>
<td>K-562</td>
<td>Female</td>
<td>Cell line</td>
</tr>
</tbody>
</table>

Using the concentrations provided by the supplier, the DNA samples were diluted to 2.0 ng/μL (A), 0.5 ng/μL (B), and 0.1 ng/μL (C).

Note: All dilutions were made in T<sub>10</sub>E<sub>0.1</sub> Buffer with 20 μg/mL glycogen added as a carrier and stabilizer.

All samples and dilutions were tested in successive runs using the Quantifiler<sup>®</sup> Human Kit and the Quantifiler<sup>®</sup> Y Kit. Three different runs were performed. Each assay contained two reactions for each of the quantification standards and one reaction for each of the samples.

For each sample reaction the C<sub>T</sub><sub>FAM</sub> values were obtained and the DNA quantity calculated. The mean quantity and standard deviations were calculated for each sample. The 95% confidence interval values were calculated as the mean of the DNA quantity ± two standard deviation units for each sample and expressed as a percentage of the mean quantification result.

Results

The following tables show the DNA quantity calculated for all samples and dilutions tested for all three runs using the Quantifiler<sup>®</sup> Human Kit (Table 17) and the Quantifiler<sup>®</sup> Y Kit (Table 18).

Table 17 Reproducibility using the Quantifiler<sup>®</sup> Human Kit

<table>
<thead>
<tr>
<th>Sample</th>
<th>DNA Quantity [ng/μL]</th>
<th>Standard Deviation</th>
<th>95% Confidence (± percent)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Run 1</td>
<td>Run 2</td>
<td>Run 3</td>
</tr>
<tr>
<td>007 A</td>
<td>2.580</td>
<td>2.830</td>
<td>2.900</td>
</tr>
<tr>
<td>007 B</td>
<td>0.894</td>
<td>0.779</td>
<td>0.892</td>
</tr>
<tr>
<td>007 C</td>
<td>0.216</td>
<td>0.160</td>
<td>0.192</td>
</tr>
<tr>
<td>9948 A</td>
<td>2.300</td>
<td>2.240</td>
<td>2.210</td>
</tr>
<tr>
<td>9948 B</td>
<td>0.504</td>
<td>0.481</td>
<td>0.573</td>
</tr>
<tr>
<td>9948 C</td>
<td>0.123</td>
<td>0.132</td>
<td>0.132</td>
</tr>
<tr>
<td>Human genomic A</td>
<td>1.810</td>
<td>1.790</td>
<td>2.240</td>
</tr>
<tr>
<td>Human genomic B</td>
<td>0.495</td>
<td>0.468</td>
<td>0.504</td>
</tr>
</tbody>
</table>
### Table 18 Reproducibility using the Quantifier® Y Kit

<table>
<thead>
<tr>
<th>Sample</th>
<th>DNA Quantity (ng/μL)</th>
<th>Standard Deviation</th>
<th>95% Confidence (± percent)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Run 1</td>
<td>Run 2</td>
<td>Run 3</td>
</tr>
<tr>
<td>Human genomic C</td>
<td>0.128</td>
<td>0.106</td>
<td>0.106</td>
</tr>
<tr>
<td>K-562 A</td>
<td>1.360</td>
<td>1.350</td>
<td>1.360</td>
</tr>
<tr>
<td>K-562 B</td>
<td>0.379</td>
<td>0.425</td>
<td>0.460</td>
</tr>
<tr>
<td>K-562 C</td>
<td>0.096</td>
<td>0.126</td>
<td>0.096</td>
</tr>
<tr>
<td>Raji-1 A</td>
<td>1.920</td>
<td>1.800</td>
<td>1.770</td>
</tr>
<tr>
<td>Raji-1 B</td>
<td>0.484</td>
<td>0.402</td>
<td>0.466</td>
</tr>
<tr>
<td>Raji-1 C</td>
<td>0.149</td>
<td>0.120</td>
<td>0.104</td>
</tr>
<tr>
<td>Raji-2 A</td>
<td>1.720</td>
<td>1.860</td>
<td>1.700</td>
</tr>
<tr>
<td>Raji-2 B</td>
<td>0.419</td>
<td>0.407</td>
<td>0.408</td>
</tr>
<tr>
<td>Raji-2 C</td>
<td>0.113</td>
<td>0.088</td>
<td>0.061</td>
</tr>
</tbody>
</table>

† n.d. = not determined
The 95% confidence interval shows the approximate range expected for results when using the Quantifiler® Kits. The average 95% confidence interval for each kit:

- Quantifiler® Human Kit: ±18.5%
- Quantifiler® Y Kit: ±26.9%

The data show that as the DNA concentration decreases, the amount of variability in the quantification results increases. This results from stochastic effects—the statistical principles involved when testing DNA samples with low concentrations. Stochastic effects may cause imbalance or dropouts of alleles when performing STR analysis of DNA samples with low concentrations.

### Specificity with a Human DNA Panel

Purified genomic DNA samples from 500 human individuals were obtained from two different commercial sources. Many of the samples were extracted from cell lines that provide distinct genotypes for forensic validation work; other samples were extracted from blood specimens. The sex of all samples was confirmed by genotypic analysis using the AmpF/STR® Identifiler® PCR Amplification Kit (amelogenin locus).

**Experiment**

Approximately 20 to 40 ng of purified genomic DNA from the Human DNA Panel was used for each Quantifiler® Kit reaction.

Sequence Detection Systems (SDS) software was used to analyze the data and calculate the C_T FAM value:

<table>
<thead>
<tr>
<th>C_T FAM Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>C_T FAM &lt; 40</td>
<td>+</td>
</tr>
<tr>
<td>No amplification after 40 cycles</td>
<td>−</td>
</tr>
</tbody>
</table>

**Results**

The results in Table 19 show that:

- The Quantifiler® Human Kit detected all 500 human DNA samples.
- The Quantifiler® Y Kit detected all 240 male DNA samples and none of the female DNA samples.

**Table 19** Specificity with human DNA panel

<table>
<thead>
<tr>
<th>Sex</th>
<th>Quantifiler® Human Kit</th>
<th>Quantifiler® Y Kit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male [240]</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Female [260]</td>
<td>+</td>
<td>−</td>
</tr>
</tbody>
</table>
Specificity with a Non-Human Panel

Samples were obtained either as purified DNA or as whole blood from individual animals. For some of the purified DNA samples, the sex of the donor animals was unknown; for remaining samples, the sex and identity of the animals was known. For some species, multiple individuals were tested.

Experiment

For many of the reactions, approximately 0.25 to 1.0 ng of DNA was used in each reaction. For a few reactions, up to 40 ng of DNA was used in one reaction.

SDS software was used to analyze the data and calculate the $C_T$ FAM value:

<table>
<thead>
<tr>
<th>$C_T$ FAM Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C_T$ FAM &lt;40</td>
<td>+</td>
</tr>
<tr>
<td>No amplification after 40 cycles</td>
<td>-</td>
</tr>
</tbody>
</table>

Results

The two human control samples that were tested show expected results (as shown in Table 20).

Quantifiler® Human Kit results

The Quantifiler® Human Kit detected DNA from humans and apes, with some less-efficient detection of one other primate. The Quantifiler® Human Kit:

- Detected DNA from all of the higher ape DNA samples (chimpanzee, gorilla, and orangutan) at an efficiency similar to that of humans
- Detected DNA from macaque monkeys at a significantly reduced efficiency, possibly because of partial homology between the primers and probe and the macaque DNA
- Did not detect DNA from the remaining species

Quantifiler® Y Kit results

The Quantifiler® Y Kit detected DNA from male humans and chimpanzees but from no other species tested.

Of the DNA samples that were detected using the Quantifiler® Human Kit (gorilla, chimpanzee, orangutan, and macaque), the Quantifiler® Y Kit:

- Detected DNA from the chimpanzees
- Did not detect DNA from the male gorilla
- Did not detect DNA from the female orangutans or macaques
### Table 20 Specificity with non-human panel

<table>
<thead>
<tr>
<th>Organism</th>
<th>Sex</th>
<th>Result Quantifiler® Human Kit</th>
<th>Result Quantifiler® Y Kit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gorilla (2)</td>
<td>Female†</td>
<td>+</td>
<td>−</td>
</tr>
<tr>
<td>Chimpanzee (2)</td>
<td>Unknown</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Orangutan (2)</td>
<td>Female†</td>
<td>+</td>
<td>−</td>
</tr>
<tr>
<td>Macaque (2)</td>
<td>Female†</td>
<td>±†</td>
<td>−</td>
</tr>
<tr>
<td>Cat</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Dog</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Pig</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Cow</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Mouse</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Rabbit</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Hamster</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Rat</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Chicken</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Fish</td>
<td>Unknown</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Gorilla Male</td>
<td>Male</td>
<td>+</td>
<td>−</td>
</tr>
<tr>
<td>Cat Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Dog (2) Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Mouse Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Rabbit Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Rat Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Horse (2) Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Bovine Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Sheep Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Pig Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Deer Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Chicken Male</td>
<td>Male</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Human Female</td>
<td>Female</td>
<td>+</td>
<td>−</td>
</tr>
<tr>
<td>Human Male</td>
<td>Male</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>

† Sex confirmed by STR analysis.
‡ Weak but positive amplification with higher Ct values and lower Rn values than normal for the input amount of DNA in the reaction.
Specificity with a Bacterial Pools Panel

The bacterial pools panel contained purified genomic DNA from 53 bacterial species and one yeast species. The panel included:

- Common gram-negative and gram-positive species
- Species associated with the human gut (for example, *Proteus*, *Providencia*, *Alcaligenes*)
- Species associated with food (*Lactobacillus* spp.)
- Species associated with spoilage and decomposition (for example, *Pseudomonas*, *Flavobacterium*, *Clostridium*, *Candida*)
- Species associated with human enteric disease (for example, *Salmonella*, *Escherichia coli*, *Yersinia*).
- Several species of *Bacillus*, a common and pervasive bacterial genus.

**Experiment**

There were approximately $1 \times 10^5$ genome copies of each species in each reaction.

SDS software was used to analyze the data and calculate the $C_{T,FAM}$ value:

<table>
<thead>
<tr>
<th>$C_{T,FAM}$ Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C_{T,FAM} &lt; 40$</td>
<td>+</td>
</tr>
<tr>
<td>No amplification after 40 cycles</td>
<td>–</td>
</tr>
</tbody>
</table>

**Results**

The Quantifiler® Human Kit and the Quantifiler® Y Kit did not detect DNA from any of the bacterial or yeast species tested.

**Table 21** Specificity with bacterial pools panel

<table>
<thead>
<tr>
<th>Species Composition</th>
<th>Quantifiler® Human Kit</th>
<th>Quantifiler® Y Kit</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Lactobacillus acidophilus, Lactobacillus delbrueckii</em> [2], <em>Lactobacillus rhamnosus, Lactobacillus casei</em></td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td><em>Brochothrix thermosphacta, Brochothrix campestris, Aerococcus viridians, Kurthia gibsonii, Alcaligenes faecalis</em></td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td><em>Bacillus subtilis, Bacillus cereus, Bacillus licheniformis, Bacillus mycoides, Bacillus stearothermophilus</em></td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td><em>Pseudomonas fluorescens, Flavobacterium odoratum, Clostridium sporogenes, Candida kefyr</em> (yeast), <em>Deinococcus radiodurans</em></td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td><em>Lactococcus lactis, Bordetella bronchiseptica, Acinetobacter baumannii, Aeromonas caviae, Corynebacterium variabile</em></td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td><em>Nocardia asteroides, Stenotrophomonas maltophilia, Bacillus coagulans, Rhodococcus equi, Acinetobacter calcoaceticus</em></td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td><em>Propionibacterium acnes, Clostridium difficile, Fusebacterium necrophorum, Burkholderia cepacia, Delftia acidovorans</em></td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td><em>Micrococcus luteus, Streptomyces rimosus, Gordonia sputi, Legionella ansia, Pasteurella aerogenes</em></td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>
Sensitivity

Human genomic DNA samples were obtained from different commercial sources. For each DNA sample, a dilution series was made and each dilution was tested with the Quantifiler® Human Kit and the Quantifiler® Y Kit.

DNA samples tested

Five different human DNA samples were tested.

Table 22 Human DNA samples tested for sensitivity

<table>
<thead>
<tr>
<th>Species Composition</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quantifiler® Human Kit</strong></td>
<td><strong>Quantifiler® Y Kit</strong></td>
</tr>
<tr>
<td><em>Citrobacter freundii, Klebsiella pneumoniae, Escherichia hermanii,</em></td>
<td>–</td>
</tr>
<tr>
<td><em>Enterobacter cloaca, Escherichia coli O157:H7</em></td>
<td>–</td>
</tr>
<tr>
<td><em>Salmonella enteritidis, Shigella dysenteriae, Proteus vulgaris,</em></td>
<td>–</td>
</tr>
<tr>
<td><em>Pseudomonas aeruginosa, Hafnia alvei</em></td>
<td>–</td>
</tr>
<tr>
<td><em>Yersinia enterocolitica, Campylobacter coli, Providencia stuartii,</em></td>
<td>–</td>
</tr>
<tr>
<td><em>Vibrio parahaemolyticus, Alcaligenes faecalis</em></td>
<td>–</td>
</tr>
</tbody>
</table>

Experiment

Using the concentrations provided by the suppliers, five-fold serial dilutions of the DNA samples were made. Concentrations ranged from 10 ng/μL to 0.016 ng/μL (16 pg/μL).

Note: All dilutions were made in T10E0.1 Buffer with 20 μg/mL glycogen added as a carrier and stabilizer.

For each 25-μL reaction, 2.0 μL of DNA sample was used.

Results

A plot of the $C_T$ values versus the known DNA quantities showed the expected log-linear relationship between the two quantities. All dilutions, including samples at the lowest concentration (16 pg/μL), gave positive results for the Quantifiler® Human Kit and the Quantifiler® Y Kit. For each dilution series, the data points formed an acceptable standard curve. The small differences in $C_T$ values among the dilutions of different DNA samples likely reflect differences in the quantification measurements made by each supplier.
Stability

DNA samples from various origins are commonly contaminated with organic and inorganic compounds that inhibit the amplification of nucleic acids by PCR. These PCR inhibitors can interfere with the reaction and cause varying levels of reduced PCR efficiency, including complete inhibition of PCR. A wide variety of PCR inhibitors has been reported, including in DNA samples extracted from blood stains. One example is hematin, which has been found in DNA samples extracted from blood stains. Because the solubility of hematin is similar to that of DNA, it is thought that it is extracted and purified with the DNA. The presence of hematin in DNA samples may interfere with PCR by inhibiting polymerase activity.

Bovine serum albumin (BSA) is used in enzymatic reactions because it appears to increase the efficiency of the PCR reaction, most likely acting as a chelating agent with many inhibitors. BSA is added to the Quantifiler® Kit and AmpFISTR® Kit reaction mixes specifically to counteract the presence of PCR inhibitors.
Human genomic DNA was mixed with varying concentrations of hematin: 0 μM, 10 μM, 12 μM, 14 μM, 16 μM, 18 μM, 20 μM, and 40 μM. 2.0 μL of each DNA/hematin mix, containing 1.0 ng total of human DNA, was quantified using the Quantifiler® Human Kit and Quantifiler® Y Kit; the same amounts of samples were added to reactions using the AmpFSTR® Identifiler® PCR Amplification Kit (For Forensic or Paternity Use Only). Identifiler kit reactions were analyzed on a 3100 instrument. Data were analyzed with GeneScan® Software v3.7.1 and Genotyper® Software v3.7, for use with the Windows NT® operating system.

Results

Amplification plots (Figure 14 and Figure 15) showed lower ΔRn values and higher CT values as the concentration of hematin increased. CT results and corresponding quantification results were relatively stable up to 14 μM hematin, with results more affected at higher concentrations. As the concentration of hematin increased, the PCR efficiency in the Quantifiler® Kit reactions and the AmpFSTR® Identifiler® Kit reactions decreased. For the Quantifiler® Human Kit, complete inhibition occurred at 40 μM, and for the Quantifiler® Y Kit, complete inhibition occurred at 18 μM, 20 μM, and 40 μM. The inhibition may be stronger with the Quantifiler® Y Kit because there is only one copy of the haploid Y chromosome target locus for the Quantifiler® Y Kit and two copies of the diploid autosomal target locus for the Quantifiler® Human Kit.

The IPC system is more sensitive to PCR inhibition. For the Quantifiler® Human Kit, in samples containing more than 16 μM hematin, amplification of IPC detectors failed. In samples containing less hematin, amplification of IPC detectors was inhibited (Figure 16). Although the Human detector amplified for the 16 μM, 18 μM and 20 μM hematin samples, the failure of IPC amplification in those reactions indicates that the presence of PCR inhibitors is likely. Because the IPC system components are the same in both Quantifiler® Kits, the IPC results for the Quantifiler® Y Kit were similar to those for the Quantifiler® Human Kit.

Figure 14 Inhibition studies: Quantifiler® Human Kit
Figure 15  Inhibition studies: Quantifiler® Y Kit

Figure 16  Inhibition studies: IPC detector

The results of STR analysis using the Identifiler® Kit (Figure 17) were consistent with the results from the Quantifiler® Kits: as the concentration of hematin increased, the overall STR peak profile decreased. Complete STR profiles were obtained at hematin concentrations up to 20 μM. The STR amplification reaction was completely inhibited by 40 μM hematin. The results from the Quantifiler® Kits provided reasonable predictions of samples that would fail STR analysis because of the presence of the PCR inhibitor. The STR profiles for the positive and negative controls are included for reference.
**Mixture Studies**

The mixture studies in this section were designed to simulate circumstances in which a small component of male DNA must be discerned from a high background of female DNA. Evidence samples may contain DNA from more than one individual, and this should be considered when interpreting the results. Life Technologies recommends that individual laboratories assign a minimum peak height threshold based on validation experiments performed in each laboratory.

**Experiment**

Purified genomic DNA from the Raji (male) and K-562 (female) cell lines were mixed in ratios of 1:1, 1:4, 1:16, 1:64, 1:256 and 1:1024 (Raji:K-562). The male DNA was added at a constant level of 0.05 ng/μL in all samples, and the female DNA was present at amounts ranging from 0.05 ng/μL in the 1:1 sample to 50 ng/μL in the 1:1024 sample. The DNA amounts were calculated based only on the DNA concentrations provided by the suppliers and were not calibrated with the Quantifiler® Kits.
The mixtures were tested with the Quantifiler® Human Kit and the Quantifiler® Y Kit to determine the concentrations of total human genomic DNA (Quantifiler® Human Kit) and male DNA only (Quantifiler® Y Kit). For each sample, three replicate reactions were performed for each assay. Each assay used the same set of 8 human genomic DNA quantification standards run in duplicate reactions for each assay and both assays were run on the same reaction plate. The reaction plates were run on a 7000 instrument.

**Results**

The quantification results (Figure 18) from using the Quantifiler® Human Kit varied from an average of 0.16 ng/μL for the 1:1 sample to 38 ng/μL for the 1:1024 sample, consistent with the increasing amounts of female DNA present.

The quantification results from using the Quantifiler® Y Kit varied from between 0.034 ng/μL to 0.063 ng/μL for all samples, regardless of the amount of female DNA present.

For the 1:1024 sample, the results showed a ratio of male DNA to total DNA of 1:974. Differences between target concentrations and actual measurements were expected because the amounts of DNA added to the mixtures were based only on the DNA concentrations provided by the suppliers and were not calibrated with the Quantifiler® Kits.

In all samples, the male DNA was detected and quantified accurately, regardless of the amount of female DNA present.

**Figure 18** DNA quantities determined in mixture studies

<table>
<thead>
<tr>
<th>Male:Female Mixture Ratio</th>
<th>DNA Quantity (ng/μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1</td>
<td>0.16</td>
</tr>
<tr>
<td>1:5</td>
<td>0.34</td>
</tr>
<tr>
<td>1:16</td>
<td>0.63</td>
</tr>
<tr>
<td>1:64</td>
<td>3.8</td>
</tr>
<tr>
<td>1:256</td>
<td>38.0</td>
</tr>
<tr>
<td>1:1024</td>
<td>380.0</td>
</tr>
</tbody>
</table>

**Degraded DNA Studies**

Forensic samples may be exposed to environmental conditions that degrade DNA molecules and reduce their amplification efficiency in PCR reactions. Exposure to environmental conditions can reduce the overall DNA concentration and may cause fragmentation of full-length DNA molecules into smaller fragments. DNA fragmentation makes it difficult to amplify longer segments such as the larger STR loci. Because of such potential occurrences, the validation of forensic DNA methods often involves studies of the effects of degradation on the amplification and detection of DNA.
The Quantifiler® Kits were tested with DNA degraded with the DNA nuclease DNase I. The degraded DNA samples were tested with the Quantifiler® Human Kit and the Quantifiler® Y Kit to determine the quantity of amplifiable DNA in each time point. Results obtained using the Quantifiler® Kits were used to calculate DNA input for an STR assay using an ABI PRISM® 3100 Genetic Analyzer.

Experiment

A time-course of exposure to DNase I was performed on a sample of high molecular weight human genomic DNA to generate a series of samples with varying levels of degradation. The time points in the DNase I treatment were 0 minutes (untreated), 1 minute, 2 minutes, 3 minutes, 4 minutes, 5 minutes, 15 minutes and 60 minutes. Samples from all time points were run on a 2% agarose gel for 25 minutes and visualized by staining with ethidium bromide. The treated DNA samples were examined by agarose gel electrophoresis to determine the average size of the DNA fragments at each time point. The degraded DNA samples were tested with the Quantifiler® Human Kit and the Quantifiler® Y Kit to determine the quantity of amplifiable DNA in each time point.

Using the results from the Quantifiler® Kits, the volumes of DNA required for AmpFISTR® Identifiler® Kit reactions were calculated so that 1.0 ng/μL was added for each reaction. The PCR products were run on an ABI PRISM® 3100 Genetic Analyzer.

Results

Agarose gel electrophoresis showed that the DNase I treatment reduced the average size of DNA fragments to 100 basepairs (bp) or less within the first 5 minutes (Figure 19).

Figure 19 DNase I degradation of human genomic DNA

The results from the Quantifiler® Kits (Figure 20 and Figure 21) showed higher C_T values with longer DNase exposure times, corresponding to lower amounts of amplifiable DNA in the samples. According to results from the Quantifiler® Human Kit, the amount of amplifiable DNA decreased from 12.0 ng/μL to 1.2 ng/μL at the 5-minute time point and to 0.11 ng/μL at the 15-minute time point. At the 60-minute time point, no amplifiable DNA was detected.
Using the DNA quantification results from the Quantifiler® Human Kit, 1.0 ng of each DNA sample was added to Identifiler® Kit reactions. As the concentration of amplifiable DNA decreased because of degradation, the sample volume required in the reaction increased.

Identifiler® Kit results at 1.0 ng/μL produced complete STR profiles up to the 5-minute time point, although the amount of amplifiable DNA (according to the Quantifiler® Kits) was reduced by 90% relative to the untreated control (Figure 22). The peak heights were reduced for the more degraded samples, but profiles were still detected. The 15-minute time point contained only 1% of the original amount of amplifiable DNA and produced only a partial STR profile of mostly smaller molecular weight loci. At 60 minutes, no DNA was detected by the Quantifiler® Kits (Figure 20 and Figure 21) or the Identifiler® Kit (Figure 22).

The Quantifiler® Kits can be used to report the amount of amplifiable DNA in a sample but not the amount of DNA degradation. Using the quantification data from the kits to determine the amount of sample input for STR analysis may help to correct for the loss of amplifiable DNA because of degradation, but if the level of DNA degradation is so high that the remaining DNA fragments are too small, the sample will not amplify by using the Quantifiler® Kits or the STR Kits.
Comparisons with other methods

Purified DNA samples were quantified using the Quantifiler® Human Kit and the Quantifiler® Y Kit. The results were compared to results obtained from measuring absorbance at 260 nm ($A_{260}$), using a dye intercalation method, and using the Quantiblot® Human DNA Quantitation Kit (Life Technologies).

The methods tested show different sensitivity ranges and different specificities.

Table 23  Comparison: sensitivity and specificity of methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Sensitivity</th>
<th>Specificity</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A_{260}$</td>
<td>Cannot detect DNA in the picogram range.</td>
<td>Not specific for human genomic DNA. Detects single-stranded DNA, double-stranded DNA, and RNA.</td>
</tr>
<tr>
<td>Dye intercalation</td>
<td>25 pg/mL†</td>
<td>Not specific for human genomic DNA</td>
</tr>
<tr>
<td>Quantiblot kit</td>
<td>2 ng/μL to 0.03125 ng/μL</td>
<td>Specific for human genomic DNA</td>
</tr>
</tbody>
</table>

† Value obtained from the manufacturer’s documentation.
Comparison with $A_{260}$ and Quantiblot® Kit

The concentration of DNA was measured for 50 human genomic DNA samples using a $A_{260}$ method, the Quantiblot kit, and the Quantifiler® Kits. The DNA quantification results were compared.

Resolution panel

The resolution panel, a set of 50 human genomic DNA samples purified from blood, was tested. The samples were database type samples because they were extracted from blood specimens and had uniform high concentrations of DNA between approximately 10 and 20 ng/μl. All samples were within the range of sensitivity for the $A_{260}$ method.

Experiment

Each DNA sample was quantified using:

- **$A_{260}$ method** – Absorbance at 260 nm was measured. DNA concentration was calculated using the formula:

  \[ \text{Concentration (μg/mL)} = 50 \times A_{260} \]

- **Quantiblot® Kit** – DNA was quantified using a protocol for chemiluminescence detection with film autoradiography.

- **Quantifiler® Kits** – DNA was quantified using the standard procedure.

For each sample, the percent differences between Quantifiler® Kits results and results from the other two methods were calculated. The differences were expressed as a percentage of the reference method. For each method, the average percent differences from Quantifiler® Kit results were calculated. For comparisons with the Quantifiler® Y Kit, only results from male samples were used.

Results

Table 24 shows the DNA quantification results for all 50 samples in the resolution panel and for the three methods. The table also shows the percent differences between the results from the Quantifiler® Kits and the other two methods. There is no A260 data for two samples (13 and 17), and all female samples were excluded from the comparisons to the Quantifiler® Y Kit results.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Sex</th>
<th>$A_{260}$ Result (ng/μL)</th>
<th>QB† Result (ng/μL)</th>
<th>Quantifiler® Human Kit</th>
<th>Quantifiler® Y Kit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Result (ng/μL)</td>
<td>% Diff. from $A_{260}$</td>
</tr>
<tr>
<td>1</td>
<td>M</td>
<td>17.5</td>
<td>20</td>
<td>6.69</td>
<td>61.7</td>
</tr>
<tr>
<td>2</td>
<td>M</td>
<td>15.4</td>
<td>20</td>
<td>14.3</td>
<td>7.1</td>
</tr>
<tr>
<td>3</td>
<td>M</td>
<td>13.9</td>
<td>30</td>
<td>15.48</td>
<td>11.4</td>
</tr>
<tr>
<td>4</td>
<td>M</td>
<td>11.4</td>
<td>20</td>
<td>12.44</td>
<td>9.6</td>
</tr>
<tr>
<td>5</td>
<td>M</td>
<td>10.3</td>
<td>20</td>
<td>12.69</td>
<td>23.2</td>
</tr>
<tr>
<td>6</td>
<td>M</td>
<td>13.9</td>
<td>20</td>
<td>12.54</td>
<td>9.8</td>
</tr>
<tr>
<td>7</td>
<td>M</td>
<td>11.5</td>
<td>40</td>
<td>13.78</td>
<td>20.1</td>
</tr>
<tr>
<td>8</td>
<td>M</td>
<td>11.2</td>
<td>20</td>
<td>13.51</td>
<td>21.2</td>
</tr>
<tr>
<td>9</td>
<td>M</td>
<td>9.8</td>
<td>20</td>
<td>15.09</td>
<td>54.0</td>
</tr>
</tbody>
</table>
### Comparison with A260 and Quantiblot Kit

<table>
<thead>
<tr>
<th>Sample</th>
<th>Sex</th>
<th>A260 Result (ng/μL)</th>
<th>QB† Result (ng/μL)</th>
<th>Quantifiler® Human Kit Result (ng/μL)</th>
<th>% Diff. from A260</th>
<th>% Diff. from QB</th>
<th>Quantifiler® Y Kit Result (ng/μL)</th>
<th>% Diff. from A260</th>
<th>% Diff. from QB</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>M</td>
<td>9.7</td>
<td>20</td>
<td>13.98</td>
<td>44.1</td>
<td>30.1</td>
<td>12.29</td>
<td>26.7</td>
<td>38.6</td>
</tr>
<tr>
<td>11</td>
<td>M</td>
<td>13.0</td>
<td>20</td>
<td>11.27</td>
<td>13.3</td>
<td>43.7</td>
<td>12.85</td>
<td>1.2</td>
<td>35.8</td>
</tr>
<tr>
<td>12</td>
<td>M</td>
<td>13.3</td>
<td>30</td>
<td>9.92</td>
<td>25.1</td>
<td>66.9</td>
<td>11.59</td>
<td>12.5</td>
<td>61.4</td>
</tr>
<tr>
<td>13</td>
<td>M</td>
<td>nd</td>
<td>14</td>
<td>13.90</td>
<td>n.d.</td>
<td>0.7</td>
<td>11.31</td>
<td>n.d.</td>
<td>19.2</td>
</tr>
<tr>
<td>15</td>
<td>M</td>
<td>15.7</td>
<td>16</td>
<td>12.62</td>
<td>19.4</td>
<td>21.1</td>
<td>13.89</td>
<td>11.2</td>
<td>13.2</td>
</tr>
<tr>
<td>16</td>
<td>M</td>
<td>12.1</td>
<td>24</td>
<td>13.09</td>
<td>8.2</td>
<td>45.5</td>
<td>10.78</td>
<td>10.9</td>
<td>55.1</td>
</tr>
<tr>
<td>17</td>
<td>M</td>
<td>nd</td>
<td>20</td>
<td>12.81</td>
<td>n.d.</td>
<td>36.0</td>
<td>14.36</td>
<td>n.d.</td>
<td>28.2</td>
</tr>
<tr>
<td>18</td>
<td>M</td>
<td>13.5</td>
<td>24</td>
<td>8.18</td>
<td>39.4</td>
<td>65.9</td>
<td>10.25</td>
<td>24.1</td>
<td>57.3</td>
</tr>
<tr>
<td>19</td>
<td>M</td>
<td>13.2</td>
<td>20</td>
<td>10.37</td>
<td>21.4</td>
<td>48.2</td>
<td>13.12</td>
<td>0.6</td>
<td>34.4</td>
</tr>
<tr>
<td>20</td>
<td>M</td>
<td>12.9</td>
<td>16</td>
<td>12.69</td>
<td>1.2</td>
<td>20.7</td>
<td>12.36</td>
<td>3.8</td>
<td>22.8</td>
</tr>
<tr>
<td>21</td>
<td>M</td>
<td>11.0</td>
<td>14</td>
<td>13.48</td>
<td>22.9</td>
<td>3.7</td>
<td>13.00</td>
<td>18.5</td>
<td>7.1</td>
</tr>
<tr>
<td>22</td>
<td>M</td>
<td>11.5</td>
<td>24</td>
<td>12.23</td>
<td>6.6</td>
<td>49.0</td>
<td>12.85</td>
<td>12.0</td>
<td>46.5</td>
</tr>
<tr>
<td>23</td>
<td>M</td>
<td>10.9</td>
<td>14</td>
<td>10.91</td>
<td>0.6</td>
<td>22.1</td>
<td>11.73</td>
<td>8.1</td>
<td>16.2</td>
</tr>
<tr>
<td>24</td>
<td>M</td>
<td>12.4</td>
<td>20</td>
<td>15.19</td>
<td>22.8</td>
<td>24.1</td>
<td>14.38</td>
<td>16.2</td>
<td>28.1</td>
</tr>
<tr>
<td>25</td>
<td>M</td>
<td>10.8</td>
<td>20</td>
<td>15.21</td>
<td>41.5</td>
<td>24.0</td>
<td>18.07</td>
<td>68.1</td>
<td>9.7</td>
</tr>
<tr>
<td>26</td>
<td>F</td>
<td>13.9</td>
<td>20</td>
<td>14.00</td>
<td>1.1</td>
<td>30.0</td>
<td>--†</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>27</td>
<td>F</td>
<td>11.5</td>
<td>32</td>
<td>13.16</td>
<td>14.4</td>
<td>58.9</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>28</td>
<td>F</td>
<td>11.5</td>
<td>40</td>
<td>10.51</td>
<td>8.6</td>
<td>73.7</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>29</td>
<td>F</td>
<td>11.2</td>
<td>20</td>
<td>10.45</td>
<td>6.3</td>
<td>47.8</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>30</td>
<td>F</td>
<td>16.0</td>
<td>20</td>
<td>12.56</td>
<td>21.5</td>
<td>37.2</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>31</td>
<td>F</td>
<td>10.9</td>
<td>20</td>
<td>12.12</td>
<td>11.7</td>
<td>39.4</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>32</td>
<td>F</td>
<td>10.9</td>
<td>40</td>
<td>9.42</td>
<td>13.6</td>
<td>76.5</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>33</td>
<td>F</td>
<td>11.5</td>
<td>20</td>
<td>13.95</td>
<td>21.3</td>
<td>30.3</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>35</td>
<td>F</td>
<td>11.1</td>
<td>40</td>
<td>12.38</td>
<td>11.3</td>
<td>69.1</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>36</td>
<td>F</td>
<td>10.5</td>
<td>20</td>
<td>13.38</td>
<td>28.0</td>
<td>33.1</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>37</td>
<td>F</td>
<td>12.0</td>
<td>24</td>
<td>12.50</td>
<td>4.2</td>
<td>47.9</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>38</td>
<td>F</td>
<td>10.8</td>
<td>20</td>
<td>9.59</td>
<td>11.0</td>
<td>52.1</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>39</td>
<td>F</td>
<td>11.4</td>
<td>16</td>
<td>10.42</td>
<td>8.8</td>
<td>34.9</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>40</td>
<td>F</td>
<td>10.4</td>
<td>40</td>
<td>11.16</td>
<td>7.3</td>
<td>72.1</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>41</td>
<td>F</td>
<td>12.6</td>
<td>20</td>
<td>12.49</td>
<td>0.9</td>
<td>37.6</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>42</td>
<td>F</td>
<td>12.5</td>
<td>28</td>
<td>8.68</td>
<td>30.3</td>
<td>69.0</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>43</td>
<td>F</td>
<td>12.2</td>
<td>20</td>
<td>13.57</td>
<td>11.5</td>
<td>32.2</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>44</td>
<td>F</td>
<td>9.8</td>
<td>16</td>
<td>9.42</td>
<td>3.9</td>
<td>41.1</td>
<td>--</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
</tbody>
</table>
The different methods produced similar quantification results.

### Table 25  Average differences from $A_{260}$ and Quantiblot® Kit

<table>
<thead>
<tr>
<th>Method</th>
<th>Average Difference (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A_{260}$</td>
<td>16.9</td>
</tr>
<tr>
<td>Quantiblot</td>
<td>42.0</td>
</tr>
</tbody>
</table>

**Comparison with $A_{260}$ and dye intercalation**

The concentration of DNA was measured for 13 human genomic DNA samples using the $A_{260}$ method, a dye intercalation method, and the Quantifiler® Kits.

### DNA samples tested

Six human genomic DNA samples were obtained from different commercial sources.

<table>
<thead>
<tr>
<th>DNA</th>
<th>Sex</th>
<th>Extraction Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>007</td>
<td>Male</td>
<td>Blood</td>
</tr>
<tr>
<td>9948</td>
<td>Male</td>
<td>Cell line</td>
</tr>
<tr>
<td>Human genomic</td>
<td>Male</td>
<td>Blood</td>
</tr>
<tr>
<td>Raji-1</td>
<td>Male</td>
<td>Cell line</td>
</tr>
<tr>
<td>Raji-2</td>
<td>Male</td>
<td>Cell line</td>
</tr>
<tr>
<td>K-562</td>
<td>Female</td>
<td>Cell line</td>
</tr>
</tbody>
</table>
Experiment

Using the concentrations provided by the supplier, the DNA samples were diluted to 2.0 ng/μL (A), 0.5 ng/μL (B), and 0.1 ng/μL (C).

Note: All dilutions were made in T10E0.1 Buffer with 20 μg/mL glycogen added as a carrier and stabilizer.

All sample dilutions were quantified using the following methods:

- **A$_{260}$** – Because the concentrations of the dilutions extended below the detection limit of the spectrophotometer, ultraviolet absorbance at 260 nm was measured for only the highest dilution (2.0 ng/μL).
  
  DNA concentration was calculated from the formula:
  
  $\text{Concentration (μg/mL)} = 50 \times A_{260}$
  
  The results calculated for the 2.0 ng/μL dilutions were then extrapolated for the other dilutions (0.5 ng/μL and 0.1 ng/μL), using the known dilution factors.

- **Dye intercalation** – The microplate assay mode was used and the plate was read on an ABI Prism® 7700 Sequence Detection System (7700 SDS). All of the sample dilutions were within the detection range of the assay. The assay was run using the λ bacteriophage DNA quantification standard supplied with the kit and a quantification standard based on Raji human genomic DNA. There were significant differences between the standard curves from the λ DNA and Raji DNA. The results obtained from using the Raji DNA standard were used in this experiment because the Raji DNA was considered to be more similar to the DNA measured in these experiments and because the results from using the Raji DNA standard were closer to the results obtained by the other methods.

- **Quantifiler® Kits** – DNA was quantified using the standard procedure. The Quantifiler® Human DNA standard provided with the kits was used as recommended, with duplicate reactions for each of eight serial dilutions.

For each sample, the percent differences between Quantifiler® Kits results and results from the other two methods were calculated. The differences were expressed as a percentage of the reference method. For each method, the average percent differences from Quantifiler® kit results were calculated. For comparisons with the Quantifiler® Y Kit, only results from male samples were used.

Results

Table 27 shows the DNA concentrations calculated for all samples using the A$_{260}$ method, the dye intercalation method, Quantifiler® Human Kit and Quantifiler® Y Kit. It also shows the percent differences calculated for the comparisons between the Quantifiler® Human Kit or the Quantifiler® Y Kit and the A$_{260}$ method and the dye intercalation method.

<table>
<thead>
<tr>
<th>Sample</th>
<th>A$_{260}$ Result (ng/μL)</th>
<th>DI Result (ng/μL)</th>
<th>Quantifiler® Human Kit Result (ng/μL)</th>
<th>% Diff. from A$_{260}$</th>
<th>% Diff. from DI</th>
<th>Quantifiler® Y Kit Result (ng/μL)</th>
<th>% Diff. from A$_{260}$</th>
<th>% Diff. from DI</th>
</tr>
</thead>
<tbody>
<tr>
<td>007 A</td>
<td>2.74</td>
<td>2.502</td>
<td>2.580</td>
<td>5.8</td>
<td>3.1</td>
<td>3.760</td>
<td>37.2</td>
<td>50.3</td>
</tr>
<tr>
<td>007 B</td>
<td>0.685</td>
<td>0.756</td>
<td>0.894</td>
<td>30.5</td>
<td>18.3</td>
<td>1.180</td>
<td>72.3</td>
<td>56.2</td>
</tr>
<tr>
<td>007 C</td>
<td>0.137</td>
<td>0.176</td>
<td>0.216</td>
<td>57.7</td>
<td>22.6</td>
<td>0.238</td>
<td>73.7</td>
<td>35.1</td>
</tr>
<tr>
<td>9948 A</td>
<td>1.9</td>
<td>2.286</td>
<td>2.300</td>
<td>21.1</td>
<td>0.6</td>
<td>2.590</td>
<td>36.3</td>
<td>13.3</td>
</tr>
</tbody>
</table>
The different methods produced similar quantification results.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Result [A260 (ng/μL)]</th>
<th>Result [DI† (ng/μL)]</th>
<th>Quantifiler® Human Kit</th>
<th>Result [ng/μL]</th>
<th>% Diff. from A260</th>
<th>% Diff. from DI</th>
<th>Quantifiler® Y Kit</th>
<th>Result [ng/μL]</th>
<th>% Diff. from A260</th>
<th>% Diff. from DI</th>
</tr>
</thead>
<tbody>
<tr>
<td>9948 B</td>
<td>0.475</td>
<td>0.496</td>
<td>0.504</td>
<td>6.1</td>
<td>1.5</td>
<td></td>
<td>0.810</td>
<td>70.5</td>
<td>63.2</td>
<td></td>
</tr>
<tr>
<td>9948 C</td>
<td>0.095</td>
<td>0.103</td>
<td>0.123</td>
<td>29.5</td>
<td>19.4</td>
<td></td>
<td>0.146</td>
<td>53.7</td>
<td>41.7</td>
<td></td>
</tr>
<tr>
<td>Human genomic A</td>
<td>2.2</td>
<td>2.270</td>
<td>1.810</td>
<td>17.7</td>
<td>20.3</td>
<td></td>
<td>2.010</td>
<td>8.6</td>
<td>11.5</td>
<td></td>
</tr>
<tr>
<td>Human genomic B</td>
<td>0.55</td>
<td>0.584</td>
<td>0.495</td>
<td>10.0</td>
<td>15.2</td>
<td></td>
<td>0.577</td>
<td>4.9</td>
<td>1.1</td>
<td></td>
</tr>
<tr>
<td>Human genomic C</td>
<td>0.11</td>
<td>0.134</td>
<td>0.128</td>
<td>16.4</td>
<td>4.8</td>
<td></td>
<td>0.081</td>
<td>26.2</td>
<td>39.6</td>
<td></td>
</tr>
<tr>
<td>Raji-1 A</td>
<td>2</td>
<td>1.271</td>
<td>1.920</td>
<td>4.0</td>
<td>51.0</td>
<td></td>
<td>2.500</td>
<td>25.0</td>
<td>96.7</td>
<td></td>
</tr>
<tr>
<td>Raji-1 B</td>
<td>0.5</td>
<td>0.351</td>
<td>0.484</td>
<td>3.2</td>
<td>38.1</td>
<td></td>
<td>0.679</td>
<td>35.8</td>
<td>93.7</td>
<td></td>
</tr>
<tr>
<td>Raji-1 C</td>
<td>0.1</td>
<td>0.085</td>
<td>0.149</td>
<td>49.0</td>
<td>76.1</td>
<td></td>
<td>0.123</td>
<td>23.0</td>
<td>45.4</td>
<td></td>
</tr>
<tr>
<td>Raji-2 A</td>
<td>1.98</td>
<td>1.262</td>
<td>1.720</td>
<td>13.1</td>
<td>36.3</td>
<td></td>
<td>2.630</td>
<td>32.8</td>
<td>108.4</td>
<td></td>
</tr>
<tr>
<td>Raji-2 B</td>
<td>0.495</td>
<td>0.357</td>
<td>0.419</td>
<td>15.4</td>
<td>17.3</td>
<td></td>
<td>0.574</td>
<td>16.0</td>
<td>60.7</td>
<td></td>
</tr>
<tr>
<td>Raji-2 C</td>
<td>0.099</td>
<td>0.110</td>
<td>0.113</td>
<td>14.1</td>
<td>2.5</td>
<td></td>
<td>0.091</td>
<td>7.7</td>
<td>17.1</td>
<td></td>
</tr>
<tr>
<td>K-562 A</td>
<td>2.76</td>
<td>1.317</td>
<td>1.360</td>
<td>50.7</td>
<td>3.3</td>
<td></td>
<td>neg</td>
<td>n.d.</td>
<td>n.d.</td>
<td></td>
</tr>
<tr>
<td>K-562 B</td>
<td>0.69</td>
<td>0.365</td>
<td>0.379</td>
<td>45.1</td>
<td>3.9</td>
<td></td>
<td>neg</td>
<td>n.d.</td>
<td>n.d.</td>
<td></td>
</tr>
<tr>
<td>K-562 C</td>
<td>0.138</td>
<td>0.104</td>
<td>0.096</td>
<td>30.4</td>
<td>7.9</td>
<td></td>
<td>neg</td>
<td>n.d.</td>
<td>n.d.</td>
<td></td>
</tr>
</tbody>
</table>

† Dye intercalation method

Assay background

An experiment was performed to check the assay system for false-positive results that would indicate the presence of human DNA in a sample that contained none.

Experiment

For each Quantifiler® Kit, 48 negative control reactions were set up. PCR Mixes were prepared and dispensed into wells of the reaction plate according to the standard procedure. For each negative control reaction, 2 μL of T10E0.1 Buffer was added. All standard assay parameters were used, except that the number of thermal cycles was extended from 40 to 50 for increased stringency.
Results

Figure 23 and Figure 24 show that all 48 reactions with each assay were negative for their respective human DNA targets. The IPC reactions amplified for all reactions in both assays, indicating that the assay systems performed normally. These data show that there is no inherent false-positive background associated with the Quantifiler® Kits. However, the assays are extremely sensitive, and achieving clean results requires care in assay setup and good contamination control for reagents, instruments, and laboratory work surfaces.

Figure 23  Assay background with the Quantifiler® Human Kit

![Assay background with the Quantifiler® Human Kit](image)

Figure 24  Assay background with the Quantifiler® Y Kit

![Assay background with the Quantifiler® Y Kit](image)
Section 6.2 Applied Biosystems® 7900HT Real-Time PCR System Validation (SDS Software v2.0)

Overview

Certain performance parameters for the Quantifiler® Kits were also tested separately using the Applied Biosystems® 7900HT Sequence Detection System (7900HT SDS). The experiments performed for the 7900HT SDS were less exhaustive than those for the 7000 instrument (see previous section) and were performed to test and compare the most sensitive parameters of assay performance between the two instrument platforms.

Precision (7900HT SDS)

Experiment

One set of eight serial dilutions of the Quantifiler® Human DNA Standard was prepared. The dilutions ranged from 50 ng/μL to 23 pg/μL in three-fold increments.

Three identical runs containing both Quantifiler® Human and Y Human Male Kits were performed, each containing duplicate reactions of the dilutions for each assay. The three runs were performed on different days on the same 7900HT SDS instrument, all using standard thermal cycler conditions for the Quantifiler® Kits.

The CT FAM values were recorded and the means and standard deviations of the CT FAM values were calculated for each of the eight dilutions using the Quantifiler® Human and Y Human Male Kits.

Results

Table 28 shows the means and standard deviations of the CT FAM values calculated for all reactions of each quantification standard dilution for the Quantifiler® Human Kit and the Quantifiler® Y Kit.

<table>
<thead>
<tr>
<th>DNA Quantity (ng/μL)</th>
<th>Quantifiler® Human Kit</th>
<th>Quantifiler® Y Kit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>C_T (Mean)</td>
<td>Standard Deviation</td>
</tr>
<tr>
<td>50</td>
<td>23.83</td>
<td>0.13</td>
</tr>
<tr>
<td>16.7</td>
<td>25.36</td>
<td>0.08</td>
</tr>
<tr>
<td>5.56</td>
<td>26.79</td>
<td>0.08</td>
</tr>
<tr>
<td>1.85</td>
<td>28.14</td>
<td>0.08</td>
</tr>
<tr>
<td>0.62</td>
<td>29.56</td>
<td>0.14</td>
</tr>
<tr>
<td>0.21</td>
<td>31.00</td>
<td>0.06</td>
</tr>
<tr>
<td>0.068</td>
<td>32.51</td>
<td>0.25</td>
</tr>
<tr>
<td>0.023</td>
<td>33.86</td>
<td>0.49</td>
</tr>
</tbody>
</table>
The following results are consistent with the 7000 SDS results:

- $C_T$ vs. sample concentration
- Standard deviations of the $C_T$ values
- $C_T$ value calculated using the Quantifiler® Human Kit was lower than that for the Quantifiler® Y Kit because there is only one copy of the Y chromosome target locus and two copies of the autosomal human target locus.

The $C_T$ results for all quantification standard dilutions reactions using the Quantifiler® Human and Y Human Male Kits are displayed in and Figure 25. For each of the dilutions, the mean and the standard deviation of $C_T$ for the repeated runs is shown.

**Figure 25** Precision: Quantifiler® Human Kit $C_T$ results (7900HT SDS)

**Figure 26** Precision: Quantifiler® Y Kit $C_T$ results (7900HT SDS)

### Mixture Studies (7900HT SDS)

An experiment was performed to demonstrate the specificity of the Quantifiler® Human Kit and the Quantifiler® Y Kit in analyzing mixtures of human genomic DNA from male and female sources. The mixture studies were designed to simulate circumstances in which a small component of male DNA must be discerned from a high background of female DNA.
Experiment

Purified genomic DNA from the Raji (male) and K-562 (female) cell lines were combined in ratios of 1:1, 1:4, 1:16, 1:64, 1:256 and 1:1024 (Raji:K-562). The male DNA was added at a constant level of 0.05 ng/μL in all samples, and the female DNA was present at amounts ranging from 0.05 ng/μL in the 1:1 sample to 50 ng/μL in the 1:1024 sample. The DNA amounts were based on the DNA concentrations provided by the suppliers and were not calibrated with the Quantifiler® Kits.

The mixtures were tested with the Quantifiler® Human Kit assay and the Quantifiler® Y Kit assay to determine the concentrations of total human genomic DNA (Quantifiler® Human Kit) and male DNA only (Quantifiler® Y Kit). For each sample, three replicate reactions were performed for each assay. Each assay used the same set of 8 human genomic DNA quantification standards run in duplicate reactions for each assay and both assays were run on the same reaction plate. The reaction plates were run on a 7900HT instrument.

Results

The quantification results from using the Quantifiler® Human Kit varied from an average of 0.12 ng/μL for the 1:1 sample to 60 ng/μL for the 1:1024 sample, consistent with the increasing amounts of female DNA present.

The quantification results from using the Quantifiler® Human Kit varied from between 0.023 ng/μL to 0.058 ng/μL for all samples, regardless of the amount of female DNA present.

For the 1:1024 sample, the results showed a ratio of male DNA to total DNA of 1:1700. Differences between target concentrations and actual measurements were expected because the amounts of DNA added to the mixtures were based on the DNA concentrations provided by the suppliers and were not calibrated with the Quantifiler® Kits.

The results showed that the male DNA was detected and quantified accurately in all samples, regardless of the amount of female DNA present.
Comparisons with other methods (7900HT SDS)

Experiment

Six human genomic DNA samples were obtained from different commercial sources.

Table 29  DNA samples tested with A260 and dye intercalation (7900HT SDS)

<table>
<thead>
<tr>
<th>DNA</th>
<th>Sex</th>
<th>Extraction Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>007</td>
<td>Male</td>
<td>Blood</td>
</tr>
<tr>
<td>9948</td>
<td>Male</td>
<td>Cell line</td>
</tr>
<tr>
<td>Human genomic</td>
<td>Male</td>
<td>Blood</td>
</tr>
<tr>
<td>Raji-1</td>
<td>Male</td>
<td>Cell line</td>
</tr>
<tr>
<td>Raji-2</td>
<td>Male</td>
<td>Cell line</td>
</tr>
<tr>
<td>K-562</td>
<td>Female</td>
<td>Cell line</td>
</tr>
</tbody>
</table>

Using the concentrations provided by the supplier, the DNA samples were diluted to 2.0 ng/μL (A), 0.5 ng/μL (B), and 0.1 ng/μL (C).

All dilutions were made in T10E0.1 Buffer with 20 μg/mL glycogen added as a carrier and stabilizer.

All sample dilutions were quantified using the following methods:

- **A$_{260}$** – Because the concentrations of the dilutions extended below the detection limit of the spectrophotometer, absorbance at 260 nm was measured only for the highest dilution (2.0 ng/μL).
  
  DNA concentration was calculated from the formula:
  
  \[
  \text{Concentration (μg/mL)} = 50 \times A_{260}
  \]
  
  The results calculated for the 2.0 ng/μL dilutions were then extrapolated for the higher dilutions (0.5 ng/μL and 0.1 ng/μL) using the known dilution factors.

- **Dye intercalation** – The microplate assay mode was used and the plate was read on a 7700 SDS. All of the sample dilutions were within the detection range of the assay. The assay was run using the λ bacteriophage DNA quantification standard supplied with the kit and a quantification standard based on Raji human genomic DNA. There were significant differences between the standard curves from the λ DNA and Raji DNA. The results obtained from using the Raji DNA standard were used in these experiments because the Raji DNA was considered to be more similar to the DNA measured and because the results from using the Raji DNA standard were closer to the results obtained by the other methods.

- **Quantifiler® Kits** – DNA was quantified using the standard procedure. The Quantifiler® Human DNA standard provided with the kits was used as recommended, with duplicate reactions for each of eight serial dilutions.

For each sample, the percent differences between Quantifiler® Kit results and results from the other two methods were calculated. The differences were expressed as a percentage of the reference method. For each method, the average percent differences from Quantifiler® Kit results were calculated. For comparisons with the Quantifiler® Y Kit, only results from male samples were used.
Chapter 6  Data Analysis and Results
Comparisons with other methods (7900HT SDS)

Results

Table 30 shows the DNA concentrations calculated for all samples using the A260 method, the dye intercalation method, the Quantifiler® Human Kit, and the Quantifiler® Y Kit. It also shows the percent differences calculated for the comparisons.

Table 30  Comparison with A260 and dye intercalation (7900HT SDS)

<table>
<thead>
<tr>
<th>Sample</th>
<th>(A_{260}) Result (ng/(\mu)L)</th>
<th>(\Delta I^\dagger) Result (ng/(\mu)L)</th>
<th>Quantifiler® Human Kit</th>
<th>Quantifiler® Y Kit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(\text{Result (ng/}\mu\text{L}))</td>
<td>(% \text{ Diff. from A}_{260})</td>
<td>(% \text{ Diff. from DI})</td>
<td>(\text{Result (ng/}\mu\text{L}))</td>
</tr>
<tr>
<td>007 A</td>
<td>2.74</td>
<td>2.094</td>
<td>23.6</td>
<td>16.3</td>
</tr>
<tr>
<td>007 B</td>
<td>0.685</td>
<td>1.007</td>
<td>47.0</td>
<td>33.2</td>
</tr>
<tr>
<td>007 C</td>
<td>0.137</td>
<td>0.272</td>
<td>98.8</td>
<td>54.6</td>
</tr>
<tr>
<td>9948 A</td>
<td>1.9</td>
<td>2.215</td>
<td>16.6</td>
<td>3.1</td>
</tr>
<tr>
<td>9948 B</td>
<td>0.475</td>
<td>0.677</td>
<td>42.5</td>
<td>36.4</td>
</tr>
<tr>
<td>9948 C</td>
<td>0.095</td>
<td>0.144</td>
<td>51.1</td>
<td>39.3</td>
</tr>
<tr>
<td>Human genomic A</td>
<td>2.2</td>
<td>2.887</td>
<td>31.2</td>
<td>27.2</td>
</tr>
<tr>
<td>Human genomic B</td>
<td>0.55</td>
<td>0.805</td>
<td>46.3</td>
<td>37.9</td>
</tr>
<tr>
<td>Human genomic C</td>
<td>0.11</td>
<td>0.184</td>
<td>67.4</td>
<td>36.9</td>
</tr>
<tr>
<td>K-562 A</td>
<td>2.76</td>
<td>1.631</td>
<td>40.9</td>
<td>23.9</td>
</tr>
<tr>
<td>K-562 B</td>
<td>0.69</td>
<td>0.474</td>
<td>31.4</td>
<td>29.9</td>
</tr>
<tr>
<td>K-562 C</td>
<td>0.138</td>
<td>0.060</td>
<td>56.2</td>
<td>42.1</td>
</tr>
<tr>
<td>Raji-1 A</td>
<td>2</td>
<td>1.702</td>
<td>14.9</td>
<td>33.9</td>
</tr>
<tr>
<td>Raji-1 B</td>
<td>0.5</td>
<td>0.483</td>
<td>3.4</td>
<td>37.7</td>
</tr>
<tr>
<td>Raji-1 C</td>
<td>0.1</td>
<td>0.094</td>
<td>6.4</td>
<td>10.6</td>
</tr>
<tr>
<td>Raji-2 A</td>
<td>1.98</td>
<td>1.555</td>
<td>21.5</td>
<td>23.2</td>
</tr>
<tr>
<td>Raji-2 B</td>
<td>0.495</td>
<td>0.446</td>
<td>9.9</td>
<td>24.9</td>
</tr>
<tr>
<td>Raji-2 C</td>
<td>0.099</td>
<td>0.081</td>
<td>17.7</td>
<td>26.1</td>
</tr>
</tbody>
</table>

\(\dagger\) Dye intercalation method

The different methods produced similar quantification results.

Table 31  Average differences from \(A_{260}\) and dye intercalation (7900HT)

<table>
<thead>
<tr>
<th>Method</th>
<th>Average Difference (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Quantifiler® Human Kit</td>
</tr>
<tr>
<td>(A_{260})</td>
<td>34.8</td>
</tr>
<tr>
<td>Dye intercalation</td>
<td>29.8</td>
</tr>
</tbody>
</table>
Section 6.3 Casework Sample Analysis

Case type studies

There is a recommended optimal DNA concentration range for using AmpFlSTR® PCR Amplification kits (For Forensic or Paternity Use Only). The recommended amount of DNA input for the AmpFlSTR® Identifiler® PCR Amplification Kit is 0.5 to 1.25 ng human DNA (total per reaction), and for four-dye assays such as the AmpFlSTR® Profiler Plus® PCR Amplification Kit, 1.0 to 2.5 ng.

DNA quantification is specified as a requirement by the Scientific Working Group on DNA Analysis Methods (SWGDAM) as a preliminary step to STR genotyping (Scientific Working Group on DNA Analysis Methods, 2000).

Experiment

A set of samples consisting of both non-casework and casework samples was tested. Of the sample set, 6 samples were non-casework, consisting primarily of blood sample extracts from single sources, and 22 were casework DNA extracts from fabric, clothing, or surface swabs. All DNA samples were prepared by organic extraction.

The DNA samples were quantified using the QuantiBlot® Human DNA Quantitation Kit (Applied Biosystems®) and the Quantifier® Human Kit performed on both the 7000 SDS and 7900HT SDS. The QuantiBlot® Kit was used in the chemiluminescent autoradiography mode. Tests with the Quantifier® Kits for the 7000 SDS and 7900HT SDS were performed according to the standard procedure.

Using the results from the Quantifier® Human Kit and the 7000 SDS, between 0.8 and 1.4 ng human genomic DNA was added to each Identifiler® Kit reaction, with many of the samples added at approximately 1.0 ng per reaction. Identifiler® Kit reactions were processed on the ABI PRISM® 3100 Genetic Analyzer and analyzed using GeneScan® Software v3.7.1 and Genotyper® Software v3.7, for use with the Windows NT® operating system. The STR profiles obtained from using the Identifiler kit were analyzed. Successful STR profiles produced complete profiles with peak heights between 200 and 4000 relative fluorescence units (RFU).

Results

According to the results from the Quantifier® Human Kit reactions run on the 7000 SDS, the range of DNA concentrations was 0.06 ng/μL to 2.61 ng/μL (Table 32).

Successful STR profiles were obtained for the 28 samples that were analyzed (Figure 27). These samples contained the minimum amount of DNA recommended for optimal Identifiler kit results (50 pg/μL in a 10-μL reaction). For some samples in the original set, the volume of DNA sample remaining after DNA quantification was insufficient to perform STR assays; these samples were not included in the data presented.
### Table 32: Input for STR analysis of casework samples

<table>
<thead>
<tr>
<th>STR</th>
<th>Sample</th>
<th>Quantity (ng/μL)</th>
<th>Input Amount for Identifiler Kit (ng)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>QuantiBlot® Kit</td>
<td>Quantifiler® Human Kit and 7000 SDS</td>
</tr>
<tr>
<td>1</td>
<td>Non-casework</td>
<td>0.4</td>
<td>0.42</td>
</tr>
<tr>
<td>2</td>
<td>Non-casework</td>
<td>0.4</td>
<td>0.50</td>
</tr>
<tr>
<td>3</td>
<td>Non-casework</td>
<td>0.4</td>
<td>0.23</td>
</tr>
<tr>
<td>4</td>
<td>Non-casework</td>
<td>0.4</td>
<td>0.54</td>
</tr>
<tr>
<td>5</td>
<td>Non-casework</td>
<td>0.16</td>
<td>0.17</td>
</tr>
<tr>
<td>6</td>
<td>Non-casework</td>
<td>0.4</td>
<td>0.67</td>
</tr>
<tr>
<td>7</td>
<td>Positive control</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>8</td>
<td>Negative control</td>
<td>n.d.</td>
<td>n.d.</td>
</tr>
<tr>
<td>9</td>
<td>Cutting from shirt</td>
<td>0.4</td>
<td>0.78</td>
</tr>
<tr>
<td>10</td>
<td>Cutting from shirt</td>
<td>0.4</td>
<td>0.66</td>
</tr>
<tr>
<td>11</td>
<td>Cutting from fabric</td>
<td>0.06</td>
<td>0.093</td>
</tr>
<tr>
<td>12</td>
<td>Cutting from fabric</td>
<td>0.06</td>
<td>0.060</td>
</tr>
<tr>
<td>13</td>
<td>Cutting from denim</td>
<td>0.16</td>
<td>0.10</td>
</tr>
<tr>
<td>14</td>
<td>Cutting from sock</td>
<td>0.04</td>
<td>0.11</td>
</tr>
<tr>
<td>15</td>
<td>Cutting from sweatshirt</td>
<td>1.2</td>
<td>2.61</td>
</tr>
<tr>
<td>16</td>
<td>Cutting from cotton</td>
<td>0.4</td>
<td>0.52</td>
</tr>
<tr>
<td>17</td>
<td>Cutting from sweatshirt</td>
<td>0.4</td>
<td>0.94</td>
</tr>
<tr>
<td>18</td>
<td>Cutting from cloth</td>
<td>0.4</td>
<td>0.31</td>
</tr>
<tr>
<td>19</td>
<td>Cutting from fabric</td>
<td>0.04</td>
<td>0.23</td>
</tr>
<tr>
<td>20</td>
<td>Cutting from leather</td>
<td>0.08</td>
<td>0.10</td>
</tr>
<tr>
<td>21</td>
<td>Cutting from carpet</td>
<td>0.4</td>
<td>0.76</td>
</tr>
<tr>
<td>22</td>
<td>Cutting from cloth</td>
<td>1.6</td>
<td>1.89</td>
</tr>
<tr>
<td>23</td>
<td>Cutting from shirt</td>
<td>1.2</td>
<td>2.29</td>
</tr>
<tr>
<td>24</td>
<td>Swab from hammer</td>
<td>0.6</td>
<td>0.47</td>
</tr>
<tr>
<td>25</td>
<td>Cutting from cloth</td>
<td>0.4</td>
<td>0.45</td>
</tr>
<tr>
<td>26</td>
<td>Cutting from fabric</td>
<td>0.08</td>
<td>0.16</td>
</tr>
<tr>
<td>27</td>
<td>Cutting from carpet</td>
<td>0.4</td>
<td>1.45</td>
</tr>
<tr>
<td>28</td>
<td>Cutting from cap</td>
<td>0.4</td>
<td>0.45</td>
</tr>
<tr>
<td>29</td>
<td>Cutting from shirt</td>
<td>1.2</td>
<td>2.29</td>
</tr>
</tbody>
</table>
Figure 27  STR profiles of casework samples
Section 6.4 Applied Biosystems® 7500 Real-Time PCR System Validation (SDS Software v1.2.3)

Overview

The Quantifiler® Human Kit and the Quantifiler® Y Kit were tested (see the experiments listed below) using the Applied Biosystems® 7500 Real-Time PCR System with SDS Software v1.2.3, running on the Windows® XP operating system. The results were then compared to the previously validated ABI PRISM® 7000 Sequence Detection System with SDS Software v1.0.

The experimental data generated demonstrate that the 7500 System (SDS Software v1.2.3):

- Provides accurate results when used with the Quantifiler® Kits for the analysis of genomic DNA samples.
- Produced results that are statistically similar to the results produced on the previously validated 7000 System (SDS Software v1.0).

Validation experiments performed

- Precision and Accuracy
- Reproducibility and Sensitivity
- Background
- Auto Baseline versus Manual analysis

Materials and methods

Reagents

To minimize variables from hand pipetting and lot-to-lot reagent differences, the following set up procedures were used throughout the study:

- Eight serial dilutions were made with one lot of standard DNA provided with the Quantifiler® Kits (first dilution prepared with 500 μL DNA and 1,000 μL 10 mM Tris-HCl (pH 8.0) and 0.1 mM Na2EDTA (T10E0.1 buffer)).
- One manufactured lot of each kit was used for all validation studies:

<table>
<thead>
<tr>
<th>Kit</th>
<th>Cat. Number</th>
<th>Lot Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human Kit</td>
<td>4343895</td>
<td>0501020</td>
</tr>
<tr>
<td>Quantifiler® Y Kit</td>
<td>4343906</td>
<td>0501018</td>
</tr>
</tbody>
</table>

Instruments

Three 7500 systems (SDS Software v1.2.3) and three 7000 systems (SDS Software v1.0) were used for this study (six instruments total). Before the study, each instrument was calibrated by an Life Technologies service engineer (ROI calibration, background calibration, optical calibration, pure dye calibration, RNase P run).
The Biomek® FX Laboratory Automation Workstation was used to set up the real-time PCR reaction plates to minimize hand-pipetting variations:

- The PCR master mixes (PCR reagents with standard or sample DNA mixed together) were aliquoted into a 96-well plate (PCR master mix plate).
- Six empty 96-well plates and the PCR master mix plate were placed on the Biomek FX work surface.
- The Biomek FX aspirated 25 μL from the PCR master mix plate, then slowly dispensed it into the corresponding well in an empty 96-well plate. The plates were sealed, spun down, then quickly loaded onto a 7500 or 7000 system. This process ensured timely and precise replication of real-time PCR plates for six instruments at a time.

### Experimental setup

#### Precision and accuracy testing

On each 96-well reaction plate, six sets of standard dilutions for each Quantifiler® Kit were set up for real-time PCR. Figure 28 shows the experimental plate layout.

For each instrument, six replicate plates were run consecutively. The cycle threshold (C_T), R^2, and slope values were compared statistically to determine precision and accuracy, which established 95% confidence intervals for each instrument type.

**Figure 28** Plate layout – Precision and accuracy testing on the 7500 System (SDS Software v1.2.3) and 7000 System (SDS Software v1.0)

#### Reproducibility and sensitivity testing

On each 96-well reaction plate, the following were set up for real-time PCR:

- Standard dilution series (two replicates of each dilution point)
- Five replicate serial dilution sets of two sample DNAs (Raji and 9948B)

The experimental plate layout is shown in Figure 29.
Figure 29 Plate Layout – Reproducibility and sensitivity testing on the 7500 System (identical plate layout for both kits)

On each instrument, six replicate plates were run consecutively with each Quantifiler® Kit (for a total of 18 plates on 7500 systems and 18 plates on 7000 systems).

To demonstrate reproducibility and sensitivity, the replicate DNA samples were quantitated, and the results were compared statistically between instrument types.

Background testing Ninety-five no template controls (NTCs) and one positive control (the 50 ng/μL standard DNA dilution sample) were set up on a 96-well plate. One plate from each Quantifiler® Kit was run on each instrument (for a total of 12 plates).

Data collection

The standard thermal cycling protocol (9600 Emulation mode) described in the Chapter 3, “PCR Amplification” was used for all instrument runs.

Data analysis

Initial data compiling and analysis All runs were analyzed initially using Manual analysis mode, with the baseline set to 3 to 15 and the threshold set at 0.2.

Average values and standard deviations for $C_T$, slope, and $R^2$ were calculated for all replicate samples in a run.
For Auto-Baseline-to-Manual analysis comparisons, the run files from the 7500 System (SDS Software v1.2.3) were reanalyzed using Auto Baseline mode and a threshold of 0.2.

Statistical data analysis

For statistical analysis, the Stat-Ease Design-Expert® Software was used for all ANOVA (analysis of variance) calculations. For paired t-Tests analysis, MicroSoft® Excel® Analysis ToolPak software was used.

Precision and accuracy

For the precision and accuracy tests between the two instrument types, the following values were determined:

- Average \( C_T \)
- Average Slope
- Average \( R^2 \)
- 95% confidence intervals (CI) by ANOVA analysis

\( C_T \) results

Table 33 shows the average \( C_T \) values (95% CI) for the 7500 System (SDS Software v1.2.3) and the 7000 System (SDS Software v1.0) at each standard curve dilution.

<table>
<thead>
<tr>
<th>Standard Curve Dilution ( (\text{ng/}\mu\text{L}) )</th>
<th>50</th>
<th>16.7</th>
<th>5.56</th>
<th>1.85</th>
<th>0.62</th>
<th>0.21</th>
<th>0.068</th>
<th>0.023</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average ( C_T ) Value (95% CI)</td>
<td>23.29</td>
<td>24.98</td>
<td>26.53</td>
<td>28.05</td>
<td>29.44</td>
<td>30.86</td>
<td>32.40</td>
<td>33.98</td>
</tr>
<tr>
<td>( C_T ) Value Range (95% CI)</td>
<td>23.21 to 23.37</td>
<td>24.90 to 25.06</td>
<td>26.44 to 26.61</td>
<td>27.97 to 28.14</td>
<td>29.36 to 29.53</td>
<td>30.78 to 30.94</td>
<td>32.32 to 32.48</td>
<td>33.88 to 34.05</td>
</tr>
</tbody>
</table>

Statistically, the two instrument types resulted in significantly different \( C_T \) values (\( p <0.0001 \)) when compared with the ANOVA analysis. No significant difference in \( C_T \) values was observed when comparing results from instruments of the same type.

Slope results

Figure 30 shows the average slope values obtained for replicate standard curves run on each instrument. The slope values obtained for the 7500 System (SDS Software v1.2.3) are listed below and are within the ranges previously established on the 7000 System (SDS Software v1.0):

<table>
<thead>
<tr>
<th>Standard Curve Dilution ( (\text{ng/}\mu\text{L}) )</th>
<th>50</th>
<th>16.7</th>
<th>5.56</th>
<th>1.85</th>
<th>0.62</th>
<th>0.21</th>
<th>0.068</th>
<th>0.023</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Slope Value (95% CI)</td>
<td>23.05</td>
<td>24.56</td>
<td>26.08</td>
<td>27.53</td>
<td>29.00</td>
<td>30.33</td>
<td>31.61</td>
<td>33.03</td>
</tr>
<tr>
<td>( C_T ) Value Range (95% CI)</td>
<td>22.97 to 23.13</td>
<td>24.48 to 24.64</td>
<td>26.00 to 26.16</td>
<td>27.45 to 27.61</td>
<td>28.92 to 29.09</td>
<td>30.25 to 30.41</td>
<td>31.53 to 31.70</td>
<td>32.95 to 33.11</td>
</tr>
</tbody>
</table>

Table 33  \( C_T \) Values (95% CI)
### R² results

Figure 31 shows the average R² values obtained for replicate standard curves on each instrument. All R² values were greater than 0.98 and are within the established range.

**Figure 31 Average R² values – Replicate standard curves**

### Table: Slope Analysis

<table>
<thead>
<tr>
<th>Kit</th>
<th>Slope</th>
<th>Established Slope Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human Kit</td>
<td>-2.93 to -3.18</td>
<td>-2.9 to -3.3</td>
</tr>
<tr>
<td>Quantifiler® Y Kit</td>
<td>-3.05 to -3.36</td>
<td>-3.0 to -3.6</td>
</tr>
</tbody>
</table>

**Figure 30 Average slope values – Replicate standard curves**

**Average Slope per Instrument**

- Quantifiler Human kit
- Quantifiler Y kit
Reproducibility and sensitivity

Two sample DNAs were quantitated for this experiment. Eight 3-fold serial dilutions for each sample were run (five replicates per dilution, 40 wells per sample). The \(C_T\) values were generated in Manual analysis mode, then the quantities were calculated using the standard curve on each plate. Figure 32 shows average \(C_T\) values (each point \(n = 90\) replicates) across a set of four serial dilutions (2 ng/μL to 0.5 ng/μL) with the Quantifiler\textsuperscript{®} Human Kit and the corresponding quantitated concentrations for one DNA sample. Similar results were obtained for the second DNA sample and the Quantifiler\textsuperscript{®} Y Kit (data not shown).

As the data show, differences in \(C_T\) values do not affect calculated quantities (calculated quantities were normalized resulting in comparable concentrations on both instrument types).

**Figure 32** \(C_T\) values and quantitated concentrations – Quantifiler\textsuperscript{®} Human Kit (comparable data were obtained for the Quantifiler\textsuperscript{®} Y Kit)

![Graphs showing DNA \(C_T\) values and calculated quantitation with Quantifiler Human kit](image)

Table 34 shows the average calculated quantities for each DNA sample obtained with the Quantifiler\textsuperscript{®} Human Kit. For sample concentrations between 2 ng/μL and 0.5 ng/μL, the percent difference between the quantitated values between instrument types did not exceed 16%. No statistically significant difference was observed for calculated quantities obtained using the Quantifiler\textsuperscript{®} Human Kit on the two instrument types.
Table 34: Average Calculated DNA Quantities – Quantifiler® Human Kit

<table>
<thead>
<tr>
<th>DNA Sample</th>
<th>7000 Avg Calculated Qty. (ng/μL)</th>
<th>7000 Std. Dev.</th>
<th>7500 Avg Calculated Qty. (ng/μL)</th>
<th>7500 Std. Dev.</th>
<th>Difference Between 7000 &amp; 7500 Calculated Qty. (ng/μL)</th>
<th>% Difference of 7000 Qty. Value from 7500 Qty. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raji</td>
<td>9.33</td>
<td>0.51</td>
<td>9.14</td>
<td>0.33</td>
<td>0.19</td>
<td>2.04</td>
</tr>
<tr>
<td></td>
<td>4.58</td>
<td>0.15</td>
<td>4.24</td>
<td>0.12</td>
<td>0.34</td>
<td>7.72</td>
</tr>
<tr>
<td></td>
<td>2.30</td>
<td>0.11</td>
<td>2.09</td>
<td>0.04</td>
<td>0.21</td>
<td>9.63</td>
</tr>
<tr>
<td></td>
<td>1.16</td>
<td>0.05</td>
<td>1.07</td>
<td>0.03</td>
<td>0.09</td>
<td>8.01</td>
</tr>
<tr>
<td></td>
<td>0.59</td>
<td>0.03</td>
<td>0.55</td>
<td>0.01</td>
<td>0.04</td>
<td>6.91</td>
</tr>
<tr>
<td></td>
<td>0.27</td>
<td>0.01</td>
<td>0.26</td>
<td>0.01</td>
<td>0.01</td>
<td>3.43</td>
</tr>
<tr>
<td></td>
<td>0.15</td>
<td>0.01</td>
<td>0.15</td>
<td>0.01</td>
<td>0.00</td>
<td>3.24</td>
</tr>
<tr>
<td></td>
<td>0.08</td>
<td>0.00</td>
<td>0.07</td>
<td>0.00</td>
<td>0.01</td>
<td>8.04</td>
</tr>
<tr>
<td>9948</td>
<td>4.65</td>
<td>0.15</td>
<td>5.02</td>
<td>0.20</td>
<td>–0.37</td>
<td>7.58</td>
</tr>
<tr>
<td></td>
<td>2.33</td>
<td>0.02</td>
<td>2.34</td>
<td>0.05</td>
<td>–0.01</td>
<td>0.36</td>
</tr>
<tr>
<td></td>
<td>1.16</td>
<td>0.05</td>
<td>1.09</td>
<td>0.03</td>
<td>0.07</td>
<td>5.98</td>
</tr>
<tr>
<td></td>
<td>0.59</td>
<td>0.02</td>
<td>0.50</td>
<td>0.03</td>
<td>0.08</td>
<td>15.52</td>
</tr>
<tr>
<td></td>
<td>0.31</td>
<td>0.02</td>
<td>0.27</td>
<td>0.01</td>
<td>0.04</td>
<td>12.31</td>
</tr>
<tr>
<td></td>
<td>0.17</td>
<td>0.01</td>
<td>0.15</td>
<td>0.01</td>
<td>0.02</td>
<td>10.80</td>
</tr>
<tr>
<td></td>
<td>0.08</td>
<td>0.01</td>
<td>0.06</td>
<td>0.00</td>
<td>0.03</td>
<td>38.59</td>
</tr>
<tr>
<td></td>
<td>0.05</td>
<td>0.01</td>
<td>0.04</td>
<td>0.00</td>
<td>0.01</td>
<td>18.14</td>
</tr>
</tbody>
</table>

Table 35 shows the average calculated quantities for each DNA sample obtained with the Quantifiler® Y Kit. For sample concentrations of 2 ng/μL to 0.5 ng/μL, the percent difference between the quantitated values between instrument types did not exceed 18%. A minimal statistical difference was observed for calculated quantities obtained using the Quantifiler® Y Kit on the two instrument types (p = 0.0027).

Table 35: Average Calculated DNA Quantities – Quantifiler® Y Kit

<table>
<thead>
<tr>
<th>DNA Sample</th>
<th>7000 Ave. Calculated Qty. (ng/μL)</th>
<th>7000 Std. Dev.</th>
<th>7500 Ave. Calculated Qty. (ng/μL)</th>
<th>7500 Std. Dev.</th>
<th>Difference Between 7000 &amp; 7500 Calculated Qty. (ng/μL)</th>
<th>% Difference of 7000 Qty. Value from 7500 Qty. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raji</td>
<td>9.12</td>
<td>0.40</td>
<td>9.09</td>
<td>0.07</td>
<td>0.03</td>
<td>0.34</td>
</tr>
<tr>
<td></td>
<td>4.60</td>
<td>0.20</td>
<td>4.66</td>
<td>0.04</td>
<td>–0.06</td>
<td>1.29</td>
</tr>
<tr>
<td></td>
<td>2.53</td>
<td>0.07</td>
<td>2.36</td>
<td>0.05</td>
<td>0.17</td>
<td>7.04</td>
</tr>
<tr>
<td></td>
<td>1.29</td>
<td>0.09</td>
<td>1.19</td>
<td>0.03</td>
<td>0.10</td>
<td>8.12</td>
</tr>
<tr>
<td></td>
<td>0.66</td>
<td>0.05</td>
<td>0.62</td>
<td>0.03</td>
<td>0.05</td>
<td>7.36</td>
</tr>
<tr>
<td></td>
<td>0.33</td>
<td>0.02</td>
<td>0.30</td>
<td>0.02</td>
<td>0.02</td>
<td>7.89</td>
</tr>
<tr>
<td></td>
<td>0.15</td>
<td>0.02</td>
<td>0.14</td>
<td>0.01</td>
<td>0.02</td>
<td>11.55</td>
</tr>
<tr>
<td></td>
<td>0.07</td>
<td>0.02</td>
<td>0.057</td>
<td>0.01</td>
<td>0.01</td>
<td>19.85</td>
</tr>
</tbody>
</table>
Data analysis

Background

Figure 33 shows background amplification plots for 95 NTCs and one positive control for both kits (one plate each) run on the 7000 System (SDS Software v1.0). Figure 34 shows background amplification plots for the 7500 System (SDS Software v1.2.3).

On all instruments, the 95 NTC samples yielded negative results (all C_T values >40) with both Quantifiler® Kits.

Figure 33  Background amplification plots – 7000 System (SDS Software v1.0)

<table>
<thead>
<tr>
<th>DNA Sample</th>
<th>7000 Ave. Calculated Qty. (ng/μL)</th>
<th>7000 Std. Dev.</th>
<th>7500 Ave. Calculated Qty. (ng/μL)</th>
<th>7500 Std. Dev.</th>
<th>Difference Between 7000 &amp; 7500 Calculated Qty. (ng/μL)</th>
<th>% Difference of 7000 Qty. Value from 7500 Qty. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>9948</td>
<td>4.71</td>
<td>0.12</td>
<td>4.56</td>
<td>0.06</td>
<td>0.15</td>
<td>3.19</td>
</tr>
<tr>
<td></td>
<td>2.43</td>
<td>0.14</td>
<td>2.30</td>
<td>0.06</td>
<td>0.12</td>
<td>5.14</td>
</tr>
<tr>
<td></td>
<td>1.34</td>
<td>0.09</td>
<td>1.13</td>
<td>0.05</td>
<td>0.21</td>
<td>17.34</td>
</tr>
<tr>
<td></td>
<td>0.68</td>
<td>0.03</td>
<td>0.62</td>
<td>0.03</td>
<td>0.06</td>
<td>9.93</td>
</tr>
<tr>
<td></td>
<td>0.33</td>
<td>0.03</td>
<td>0.28</td>
<td>0.03</td>
<td>0.05</td>
<td>15.60</td>
</tr>
<tr>
<td></td>
<td>0.18</td>
<td>0.01</td>
<td>0.14</td>
<td>0.01</td>
<td>0.04</td>
<td>24.87</td>
</tr>
<tr>
<td></td>
<td>0.08</td>
<td>0.00</td>
<td>0.05</td>
<td>0.00</td>
<td>0.02</td>
<td>34.65</td>
</tr>
<tr>
<td></td>
<td>0.04</td>
<td>0.00</td>
<td>0.03</td>
<td>0.00</td>
<td>0.01</td>
<td>38.29</td>
</tr>
</tbody>
</table>

Figure 34  Background amplification plots – 7500 System (SDS Software v1.2.3)
Auto Baseline analysis versus Manual analysis

**CT precision and accuracy**

For Auto-Baseline-to-Manual analysis comparisons:

- The SDS software v1.2.3 data from the experiments described on the previous pages were reanalyzed in Auto Baseline mode (default threshold 0.2).
- The CT values were compared to each other.

Figure 35 shows the CT values obtained using the Auto Baseline and Manual analysis modes with the Quantifiler® Human Kit. Similar data were obtained for the Quantifiler® Y Kit.

No statistically significant differences were observed for CT values generated using the Auto Baseline and Manual analysis modes with either Quantifiler® Kit.

**Figure 35** Comparison of CT values between Auto Baseline and Manual analysis modes

**CT reproducibility and sensitivity**

Figure 36 shows the CT values and calculated quantities obtained using the Auto Baseline and Manual analysis modes with the Quantifiler® Human Kit. Similar data were obtained for the Quantifiler® Y Kit.

No statistically significant differences were observed for CT values and calculated quantities derived using the Auto Baseline and Manual analysis modes with either Quantifiler® Kit.
Discussion

Precision and accuracy

**7500 System Comparison:** No statistically significant differences were observed in $C_T$, slope, and $R^2$ values between replicate samples run on the 7500 System (SDS Software v1.2.3) using both Quantifiler® Kits.

**7500-to-7000 System Comparison:** Statistically significant differences in $C_T$, slope, and $R^2$ values were observed in samples run on the 7500 System (SDS Software v1.2.3) versus the 7000 System (SDS Software v1.0) using both Quantifiler® Kits. However, the data obtained from both instrument types are within the previously established parameter ranges published in the *Quantifiler® User’s Manual*, Chapter 5, Table 5-1.

Reproducibility and sensitivity

**Sensitivity:** Similar $C_T$ values and calculated DNA quantities were obtained at each of the standard curve concentrations, demonstrating similar sensitivity results between the 7000 System (SDS Software v1.0) and 7500 System (SDS Software v1.2.3).

**Calculated Quantities:** Data obtained using the Quantifiler® Human Kit showed no statistically significant difference when the calculated quantities obtained from the 7000 and 7500 systems were compared ($p = 0.22$, with 95% confidence). However, minimally significant differences were observed between the two instrument types for calculated quantities using the Quantifiler® Y Kit.

To further explore the extent of the difference between the two instrument types, the percent differences between the calculated quantities within the concentration range of 2 ng/μL to 0.5 ng/μL were determined. This range was selected because it represents the optimal input range for most STR kits. In this range, there was, at most, an 18% concentration difference between calculated quantities using the 7000 and the 7500 systems. The impact of the slight differences in calculated quantities should have minimal effect on results of STR analysis. However, laboratories should perform the appropriate studies to verify optimal input amounts for amplification.
Auto Baseline analysis versus Manual analysis

No statistically significant difference was observed for C_\text{T} values and calculated quantities derived using the Auto Baseline and Manual analysis modes on the 7500 System (SDS Software v1.2.3).

Conclusion

This validation study demonstrates that the Applied Biosystems® 7500 Real-Time PCR System with SDS Software v1.2.3 is a robust, reliable, and reproducible system for performing DNA quantification using the Quantifiler® Kits.

When statistically comparing 7500 System (SDS Software v1.2.3) results (C_\text{T}, slope, and R^2 values) to results obtained using previously validated ABI PRISM® 7000 Sequence Detection System with SDS Software v1.0:

- Differences in calculated quantities are minimal (Quantifiler® Y Kit) or insignificant (Quantifiler® Human Kit) for unknown samples using the 7500 and 7000 systems.
- The differences observed should have little effect on resulting STR amplification based on calculated DNA quantities.
- No significant difference is observed between C_\text{T} values and calculated quantities derived by using Auto Baseline and Manual analysis modes.
Section 6.5 ABI PRISM® 7000 Sequence Detection System Validation (SDS Software v1.2.3)

Overview

The Quantifiler® Human Kit and Quantifiler® Y Kit were tested (see the experiments listed below) using the ABI PRISM® 7000 Sequence Detection System with SDS Software v1.2.3, running on the Windows® 2000 operating system, then compared to the previously validated ABI PRISM® 7000 Sequence Detection System with SDS Software v1.0.

The experimental data generated demonstrate that the 7000 System (SDS Software v1.2.3):

- Provides accurate results when used with the Quantifiler® Kits for the analysis of genomic DNA samples.
- Produced results that are similar to the results produced on the previously validated 7000 System (SDS Software v1.0)

Validation experiments performed

- Precision and Accuracy
- Reproducibility and Sensitivity
- Background
- Auto Baseline versus Manual analysis

Materials and methods

Reagents

To minimize variables from hand pipetting and lot-to-lot reagent differences, the following set up procedures were used throughout the study:

- Eight serial dilutions were made with one lot of standard DNA provided with the Quantifiler® Kits (first dilution prepared with 500 μL DNA and 1,000 μL 10 mM Tris-HCl (pH 8.0) and 0.1 mM Na2EDTA (T10E0.1 buffer)).
- One manufactured lot of each kit was used for all validation studies:

<table>
<thead>
<tr>
<th>Kit</th>
<th>Cat. Number</th>
<th>Lot Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human Kit</td>
<td>4343895</td>
<td>0501022</td>
</tr>
<tr>
<td>Quantifiler® Y Kit</td>
<td>4343906</td>
<td>0501020</td>
</tr>
</tbody>
</table>

Instruments

One ABI PRISM® 7000 Sequence Detection System was used for this study under the following conditions:

- All experiments were run initially using SDS Software v1.0.
- The 7000 system computer was upgraded to SDS Software v1.2.3.
- The 7000 System (SDS Software v1.2.3) was calibrated by an Life Technologies service engineer (background calibration, pure dye calibration, RNase P run).
• For the following experiments, v1.0 data was reanalyzed using SDS Software v1.2.3:
  – Precision and Accuracy
  – Reproducibility and Sensitivity
  – Background
• For Auto Baseline versus Manual analysis experiments, new data were collected using SDS Software v1.2.3, analyzed in Auto Baseline mode, then reanalyzed in Manual mode.

**Experimental setup**

**Precision and accuracy testing**

On each 96-well reaction plate, six sets of standard dilutions for each Quantifiler® Kit were set up for real-time PCR. The experimental plate layout is shown in Figure 37.

Three replicate plates were run consecutively. The CT, slope, and R² values were compared to determine precision and accuracy.

**Reproducibility sensitivity, and background testing**

On each 96-well reaction plate, the following were set up for real-time PCR:
• Standard dilution series (two replicates of each dilution point)
• Four replicate serial dilution sets of two sample DNAs (007 and 9948B)
• Sixteen no template controls (NTCs), which served as background samples

Figure 38 shows the experimental plate layout.
One plate was run with each type of Quantifiler® Kit.

To demonstrate reproducibility and sensitivity, the replicate DNA samples were quantitated and the results were compared between each software version.

**Data collection**

The standard thermal cycling protocol (9600 Emulation mode) described in the Chapter 3, “PCR Amplification” was used for both studies.

**Data analysis**

**Initial data compiling and analysis**

All runs were analyzed initially using Manual analysis mode, with the baseline set to 3 to 15 and the threshold set at 0.2.

Average values and standard deviations for $C_T$, slope, and $R^2$ were calculated for all replicate samples in a run.

The instrument was then upgraded to SDS Software v1.2.3, then the same run files were reanalyzed and exported with the same analysis settings.

For Manual-to-Auto-Baseline analysis comparisons, the run files from the 7000 System (SDS Software v1.2.3) were reanalyzed using the Auto Baseline mode and a threshold of 0.2.

**Precision and accuracy**

For the precision and accuracy tests between the two software versions, the average $C_T$, average slope, and average $R^2$ values were determined.

**$C_T$ results**

Figure 39 through Figure 41 show $C_T$ values obtained using the SDS Software v1.0 and v1.2.3. The data consistently show that SDS Software v1.2.3 yields lower $C_T$ values (2% difference).
Figure 39  Average C_T values – Quantifiler® Human Kit – SDS Software v1.0 and v1.2.3 [error bars indicate standard deviations]

Figure 40  Average C_T values – Quantifiler® Y Kit – SDS Software v1.0 and v1.2.3 [error bars indicate standard deviations]
Figure 41  Cₜ Values per Sample – v1.0 compared to v1.2.3 – Quantifiler® Human Kit

Slope results

Figure 42 shows the average slope values obtained using the SDS software v1.2.3 compared to v1.0. The slope values obtained for the 7000 System (SDS Software v1.2.3) are within the established ranges.

<table>
<thead>
<tr>
<th>Kit</th>
<th>Slope</th>
<th>Established Slope Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human Kit</td>
<td>−2.90 to −2.97</td>
<td>−2.9 to −3.3</td>
</tr>
<tr>
<td>Quantifiler® Y Kit</td>
<td>−3.0 to −3.09</td>
<td>−3.0 to −3.6</td>
</tr>
</tbody>
</table>

A 1% slope difference is observed between the v1.2.3 and v1.0 software.

Figure 42  Average slope values – SDS Software v1.0 and v1.2.3
R² results

Figure 43 shows that SDS software v1.2.3 yields data that are within the acceptable range of R² values: 0.98 to 1 for both kits (<0.5% difference).

Figure 43  Average R² values – Quantifiler® Human Kit and Quantifiler® Y Kit – SDS Software v1.0 and v1.2.3.

Reproducibility and sensitivity

Two sample DNAs were quantitated for this experiment. Eight 2-fold serial dilutions for each sample were run (four replicates per dilution, 32 wells per sample). The C_T values were generated in Manual analysis mode, then the quantities were calculated using the standard curve on each plate.

Figure 44 shows the C_T values for 007 and 9948B across a set of eight serial dilutions (~30 ng/μL to 0.1 ng/μL) with the Quantifiler® Human Kit and the corresponding quantitated concentrations.

As the data show, differences in C_T values do not affect calculated quantities (calculated quantities were normalized, resulting in comparable concentrations from results generated with both software versions.)
Figure 44 Average CT values and quantitated DNA concentrations – 007 and 9948B – Quantifiler® Human Kit

Figure 45 shows CT results for the Quantifiler® Y Kit that differ slightly between the v1.0 analysis and the v1.2.3 analysis. However, differences in CT values do not affect calculated quantities (calculated quantities were normalized resulting in comparable concentrations from results generated with both software versions.)

Figure 45 Average CT values and quantitated DNA concentrations – 007 and 9948B – Quantifiler® Y Kit

Figure 46 shows that there was a ≤6% quantity difference between results obtained with v1.0 and v1.2.3 software.
**Background**

Figure 47 shows the background results for 16 NTCs and one positive control for both kits run on the 7000 System (SDS Software v1.0). One out of 16 NTCs for the Quantifiler® Human Kit resulted in a <40 C_T result (36.81 C_T). Remaining NTCs resulted in >40 C_T values (negative results).

**Figure 48** Background amplification plots – 7000 System (SDS Software v1.0)

Figure 48 shows the background results for 16 NTCs and one positive control for both kits reanalyzed on the 7000 System (SDS Software v1.2.3). One out of 16 NTCs for the Quantifiler® Human Kit resulted in a <40 C_T value (38.26 C_T). Overall, the NTC results do not change when analyzed with version 1.2.3.
Figure 48 Background amplification plots – 7000 System (SDS Software v1.2.3)

Auto Baseline analysis versus Manual analysis

CT Precision and Accuracy

For Manual-to-Auto-Baseline analysis comparisons:

- Data from initial runs were collected with SDS Software v 1.2.3 and analyzed in Manual analysis mode, then reanalyzed in Auto Baseline analysis mode (default threshold 0.2).
- The CT values were compared to each other.

Figure 49 and Figure 50 show the average CT values between Auto Baseline analysis and Manual analysis. There is a <2% difference between the two analysis methods for both kits.

Figure 49 Comparison of CT values between Auto Baseline and Manual analysis – Quantifiler® Human Kit (error bars indicate standard deviations)
Figure 50  Comparison of C_T values between Auto Baseline and Manual analysis – Quantifiler® Y Kit (error bars indicate standard deviations)

CT reproducibility and sensitivity
Figure 51 shows the C_T values obtained using the Auto Baseline and Manual analysis modes with the Quantifiler® Human Kit.

No significant differences were observed for C_T values generated using the Auto Baseline and Manual analysis modes with either Quantifiler® Kit.

Figure 51  Average C_T values and average calculated quantities for 9948 and 007 – Quantifiler® Human Kit (~30 ng/μL to 0.1 ng/μL)

Figure 52 shows the C_T values obtained using the Auto Baseline and Manual analysis modes with the Quantifiler® Human Kit.

No significant differences were observed for C_T values generated using the Auto Baseline and Manual analysis modes with either Quantifiler® Kit. Auto Baseline C_T values overlap the manual C_T values. The corresponding quantities also overlap.
Discussion

Precision and accuracy

The results from SDS Software v1.0 and v1.2.3 on a 7000 System slightly differ in \( C_T \) value (2% difference), slope (1%), and \( R^2 \) (<0.5%) for both Quantifiler® Kits. All v1.0 data and v1.2.3 data are within the Quantifiler® User’s Manual published parameter ranges.

Reproducibility and sensitivity

For both Quantifiler® Kits, there was a maximum difference of 6% when the calculated quantities using v1.0 and v1.2.3 were compared. Such minor differences in calculated quantities should not affect the ability to obtain interpretable STR profiles using the optimal input amount determined by individual laboratories during validation of the Quantifiler® Kits.

Manual analysis versus Auto Baseline analysis

\( C_T \) values and their corresponding calculated quantities showed a maximum 8% difference between Auto Baseline and Manual analysis modes on the 7000 System (SDS Software v1.2.3). However, the differences observed should have little effect on resulting STR amplification based on calculated DNA quantities.

Conclusion

This validation study demonstrates that the ABI PRISM® 7000 Real-Time PCR system with SDS Software v1.2.3 is a robust, reliable, and reproducible system for performing DNA quantification using the Quantifiler® Kits.

When comparing 7000 System (SDS Software v1.2.3) results (\( C_T \), slope, and \( R^2 \) values) to results obtained using the previously validated 7000 System (SDS Software v1.0):

- Small percentage differences are observed in \( C_T \), slope, and \( R^2 \) values.
- Differences in calculated quantities are minimal for unknown samples using the 7000 System (SDS Software v1.2.3) and 7000 System (SDS Software v1.0).
- The differences observed should have little effect on resulting STR amplification based on calculated DNA quantities.
- No significant difference is observed between $C_T$ values and calculated quantities derived using Auto Baseline and Manual analysis modes.
Conclusion
WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user documentation may result in personal injury or damage to the instrument or device. Ensure that anyone using this product has received instructions in general safety practices for laboratories and the safety information provided in this document.

- Before using an instrument or device, read and understand the safety information provided in the user documentation provided by the manufacturer of the instrument or device.
- Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use appropriate personal protective equipment (gloves, gowns, eye protection, etc). To obtain SDSs, see the “Documentation and Support” section in this document.
WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel read and practice the general safety guidelines for chemical usage, storage, and waste provided below, and consult the relevant SDS for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see the “Documentation and Support” section in this document.
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing).
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood).
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended in the SDS.
- Handle chemical wastes in a fume hood.
- Ensure use of primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)
- After emptying a waste container, seal it with the cap provided.
- Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.
- Ensure that the waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.
- IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.
Documentation and Support

Obtaining SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/support.

Note: For the SDSs of chemicals not distributed by Life Technologies, contact the chemical manufacturer.

Obtaining support

For the latest services and support information for all locations, go to:

www.lifetechnologies.com/support

At the website, you can:

• Access worldwide telephone and fax numbers to contact Technical Support and Sales facilities
• Search through frequently asked questions (FAQs)
• Submit a question directly to Technical Support (techsupport@lifetech.com)
• Search for user documents, SDSs, vector maps and sequences, application notes, formulations, handbooks, certificates of analysis, citations, and other product support documents
• Obtain information about customer training
• Download software updates and patches

Limited Product Warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the Life Technologies’ General Terms and Conditions of Sale found on Life Technologies’ website at www.lifetechnologies.com/termsandconditions. If you have any questions, please contact Life Technologies at www.lifetechnologies.com/support.
Bibliography


## Symbols

<table>
<thead>
<tr>
<th>*sds file</th>
<th>description (7000 SDS) 28</th>
<th>description (7900HT SDS) 41</th>
<th>saving (7000 SDS) 37</th>
<th>saving (7900HT SDS) 48</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>See also plate document (7000 SDS) and plate document (7900HT SDS)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>*sdt file</th>
<th>description (7000 SDS) 28</th>
<th>description (7900HT SDS) 41</th>
<th>saving (7000 SDS) 38</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>See also template</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Numerics

### 5’ nuclease assay
- 14, 15

### 7000 SDS
- analysis settings, checking 65
- baseline settings 58
- detectors, creating 30
- detectors, settings 65
- fluorescence detection on 16
- PCR reactions, running on 54
- plate document, analyzing 58
- plate document, setting up 29
- results, viewing 58
- starting 26
- supported configuration 26
- template, setting up 37
- threshold settings 58
- validation, SDS v1.2.3 software 124

### 7900HT SDS
- analysis settings, checking 66
- baseline settings 61
- PCR reactions, running on 55
- plate document, analyzing 61
- plate document, setting up 42
- results, viewing 61
- starting 40
- supported configuration 40
- template, setting up 48
- threshold settings 61
- validation, SDS v2.0 software 104

### 9600 Emulation box
- selection on the 7000 SDS 36
- selection on the 7900HT SDS 48

## A

### amplification plot
- abnormal plots in one column, example of 75
- about 18
- baseline spikes, example of 74
- example 18
- inconsistent replicates, example of 73
- jagged plot, example of 74
- phases of 19
- print setup 60
- printing on the 7900HT SDS 63
- troubleshooting 73
- undefined plots, example of 75
- viewing on the 7000 SDS 59
- viewing on the 7900HT SDS 62

### analysis settings
- checking on the 7000 SDS 65
- checking on the 7900HT SDS 66
- verifying on the 7000 SDS 58
- verifying on the 7900HT SDS 61

## B

### background, assay 102
- baseline
- about 21
- settings for the 7000 SDS 58
- settings for the 7900HT SDS 61

## C

### casework sample analysis 109
- chemical safety 138
- clipped results, exporting (7900HT SDS) 63
- comparisons with other methods on the 7000 SDS 97
on the 7900HT SDS 107
composite spectrum 17
computer, starting
  for the 7000 SDS 26
  for the 7900HT SDS 40
contents of kit 22
$C_T$. See threshold cycle

D

degraded DNA studies 94
Detector Manager 32
detectors (7000 SDS)
  adding to plate document 32
  analysis settings for 65
  applying for standards 32
  applying for unknown samples 34
  creating 30
detectors (7900HT SDS)
  applying for standards 45
  applying for unknown samples 46
  copying to plate document 45
  creating 43
DNA quantification standards
  dilution series, example 51
  dilution series, guidelines for 51
  guidelines for preparing 52
  materials required to prepare 51
  omitting Std. 8 67
  preparing 52
  reaction recommendation 53
See also standards

E

equipment, not included with Quantifiler kits 23
exponential phase. See geometric phase
exporting results
  on the 7000 SDS 60
  on the 7900HT SDS 63

F

fluorescence, detection of 16

G

geometric phase, amplification plot 19
glycogen, adding to $T_{10}E_{0.1}$ buffer 51

I

instrument, powering on
  for the 7000 SDS 27
  for the 7900HT SDS 40
Internal PCR Control system, See IPC system
IPC system
  about assay 14
  components 71
  detectors for, creating on the 7000 SDS 31
  detectors for, creating on the 7900HT SDS 44
  interpreting results of 71
  invalid results from 71

L

Limited Product Warranty 139
linear phase, amplification plot 19

M

Material Data Safety Sheets (MSDSs). See Safety Data
  Sheets (SDSs)
materials, not included with Quantifiler kits 23
minor groove binder, description 14
mixture studies
  on the 7000 SDS 93
  on the 7900HT SDS 105
multicomponent data
  exporting (7900HT SDS) 63
  printing (7900HT SDS) 63
  processing of 17

N

negative results 71
New Document dialog box
  7000 SDS 29
  7900HT SDS 43
nonfluorescent quencher, description 14

O

Optical Adhesive Cover, sealing plate with 53

P

passive reference
  multicomponent analysis, use in 17
  normalization using 18
  selecting in Well Inspector (7000 SDS) 33, 34
selecting in Well Inspector (7900HT SDS) 45, 46

PCR
inhibition 71
kinetic analysis of 18
phases of 19
process in 5’ nuclease assay 15
reactions, preparing 53
reactions, running on the 7000 SDS 54
reactions, running on the 7900HT SDS 55
standard, preparing 51

plate document (7000 SDS)
analyzing 58
creating from a template 38
detectors, adding 32
detectors, applying for standards 32
detectors, applying for unknown samples 34
detectors, creating 30
how used 27
sample names, adding 34
saving 37
setup examples 28
template, creating 37
template, setting up 37
thermal cycler conditions, setting 35
types 28

plate document (7900HT SDS)
analyzing 61
creating blank 43
creating from a template 50
detectors, applying for standards 45
detectors, applying for unknown samples 46
detectors, copying 45
detectors, creating 43
how used 41
sample names, adding 46
saving 48
setup examples 41
template, creating 49
template, setting up 48
thermal cycler conditions, setting 47
types 41

plateau phase, amplification plot 19
polymerization, in 5’ nuclease assay
completion of 16
precision
on the 7000 SDS 81
on the 7900HT SDS 104

printing results
on the 7000 SDS 60
on the 7900HT SDS 63
probes, about 14
pure dye spectra, how used 18

Q
Quantifiler Human detector
creating (7000 SDS) 30
creating (7900HT SDS) 43
Quantifiler Y detector
creating (7000 SDS) 31
creating (7900HT SDS) 44
quantity
assessing 77
entering for detector (7000 SDS) 33
exporting (7000 SDS) 60
printing (7000 SDS) 60
viewing (7000 SDS) 59
viewing (7900HT SDS) 63

R
R² value
interpreting 67
viewing (7000 SDS) 59
viewing (7900HT SDS) 62
raw data
about 17
printing (7000 SDS) 60
printing (7900HT SDS) 63
reactions
examples of arranging 28, 41
real-time data analysis 18
regression line formula 66
replicates
grouping in exported results (7900HT SDS) 63
results, how grouped 35, 46
report
exporting and printing on the 7000 SDS 60
exporting and printing on the 7900HT SDS 63
viewing on the 7000 SDs 59
reporter signal, normalized
about 18
viewing in amplification plot (7000 SDS) 59
viewing in amplification plot (7900HT SDS) 62
reproducibility 83
results
exporting (7900HT SDS) 63
viewing (7000 SDS) 58
viewing (7900HT SDS)  61
Rn. See reporter signal, normalized
ROX
selecting in Well Inspector (7000 SDS)  33, 34
selecting in Well Inspector (7900HT SDS)  45, 46

S
safety
chemical  138
Safety Data Sheets (SDSs), obtaining  139
technical name
adding for unknown samples (7000 SDS)  34
adding for unknown samples (7900HT SDS)  46
entering for detector (7000 SDS)  33
entering for detector (7900HT SDS)  45
SDS document. See *.sds file
SDS software
starting for 7000 SDS  27
starting for 7900HT SDS  41
SDS template. See *.sdt file
sensitivity
of assay  77
tests  89
setup table, exporting (7900HT SDS)  63
single plate document. See *.sds file (7900HT SDS)
slope of standard curve
about  66
differs significantly from -3.33  68
interpreting  67
viewing (7000 SDS)  59
viewing (7900HT SDS)  62
specificity
with bacterial pools panel  88
with non-human panel  85, 86
stability  90
standard curve
about results  66
differences in C_T values of replicates  70
interpreting  66
outlier in, example of  69
print setup (7000 SDS)  60
replicates, example of four  70
straight horizontal line  69
troubleshooting  68
viewing (7000 SDS)  58
viewing (7900HT SDS)  62
standards
applying detectors for (7000 SDS)  32
applying detectors for (7900HT SDS)  45
See also DNA quantification standards
stochastic effects  77
storage recommendations, for kits  22
strand displacement, in 5’ nuclease assay  15
support, obtaining  139

T
T10E0.1 buffer, contents of  51
TaqMan® MGB probe  14
targets, about  14
task
selecting for detector (7000 SDS)  33
selecting for detector (7900HT SDS)  45
template
creating plate document from (7000 SDS)  38
creating plate document from (7900HT SDS)  50
saving (7000 SDS)  38
saving (7900HT SDS)  49
setting up for plate documents (7000 SDS)  37
setting up for plate documents (7900HT SDS)  48
template plate document. See *.sdt file
Terms and Conditions  139
thermal cycler conditions
printing (7900HT SDS)  63
setting (7000 SDS)  35
setting (7900HT SDS)  47
threshold
settings for the 7000 SDS  58
settings for the 7900HT SDS  61
threshold cycle
calculation of  20
exporting (7000 SDS)  60
in standard curve  66
normal range for IPC system  71
printing (7000 SDS)  60
relationship to initial template amount  21
viewing in amplification plot (7900HT SDS)  62
viewing in standard curve (7900HT SDS)  62
training, information on  139

U
unknown samples
detectors, applying for (7000 SDS)  34
detectors, applying for (7900HT SDS)  46
names, adding (7000 SDS)  34
names, adding (7900HT SDS)  46
Index

V
validation
  7000 SDS, SDS v1.2.3 software  124
  7900HT Real-Time PCR System, SDS v2.0 software  104
  background, assay  102
  comparisons with other methods  97
  comparisons with other methods (7900HT SDS)  107
  degraded DNA studies  94
  importance of  80
  mixture studies  93
  mixture studies (7900HT SDS)  105
  precision  81
  precision (7900HT SDS)  104
  reproducibility  83
  sensitivity  89
  specificity with bacterial pools panel  88
  specificity with human DNA panel  85
  specificity with non-human panel  86
  stability  90

W
warranty  139

Y
y-intercept of standard curve
  interpreting  66
  viewing (7000 SDS)  59
  viewing (7900HT SDS)  62